
Chapter 12
Graphs

12.1 Introduction

The graphical representation of experimental results may serve one or more of the
following purposes:

1. To show the relationship between two quantities, bringing out characteristics
which would not be obvious in a table of numerical values.

2. The curve of the graph may be used in the evaluation of the slope or the
intercept with one of the axes, especially when the relationship between the two
magnitudes is linear. Important physical quantities and natural constants are
usually determined by this method.

3. To investigate the form of the relation connecting two variables (linear, expo-
nential etc.) which then may be expressed in the form of a mathematical
equation for greater accuracy.

4. For the verification or not of a theoretical relation between two magnitudes, by
comparison of the theoretical curve with the experimental results.

5. To determine the calibration curve of an instrument or of a process or, in
general, to enable finding the value of one of the variables corresponding to a
certain value of the other. Even if the result is present in the table of results,
reading the required value off the best curve drawn between the experimental
points gives a better value, as it is based on more than one measurement.

Having used so many graphs in the previous chapters of the book, it is certainly
unnecessary to try to put forward arguments in favor of using graphs in the pre-
sentation of information. The numerical values of a table are obviously useful, but
they do not transmit the same amount of information as a graph does. Figure 12.1
demonstrates the truth of this statement.

In this chapter we will present the main characteristics of graphs and the
criteria on the basis of which these are selected for the best presentation of the data.
We will only examine cases in which the results of measurements we have at our
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disposal are N pairs of values ðx; yÞ of a dependent variable y as a function of an
independent variable x. We wish to exhibit the relationship between the two
magnitudes in the best way.

12.2 The Axes

The first things that are drawn in a graph are the axes. The choice of these will
determine the kind of graph that will result, the range of values that will be covered
as well as the kind of curve that will be obtained.

The magnitude considered to be the independent variable is usually recorded
along the axis of the abscissae (x-axis), while the magnitude considered to be the
dependent variable is recorded along the ordinate axis (y-axis). Although the dis-
tinction is not always possible, in general, if in an experiment we set the values of
one of the variables (e.g. the potential difference across the ends of a resistance),
then this variable is considered to be the independent variable and the result (e.g.
the current through the resistance) is the dependent variable.

12.2.1 Linear Scales

In the simplest and most common graphs, we use linear scales for both x and
y. Examples of axes with linear scales have been drawn in Fig. 12.2. Although the
axes drawn are horizontal, ordinate axes may be drawn in the same manner.

The numerical values for a reasonable number of points are given on the axis, in
such a way that intermediate values of the variable would be easy to find. This is
done without overloading the axis with numbers which may cause confusion without

Fig. 12.1 Real e0ð Þ and imaginary part e00ð Þ of the dielectric constant of a material, as functions of
the frequency. The frequency scale is logarithmic and common to both quantities
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giving any useful information. Having drawn the axis and the numerical scale
corresponding to it, the name of the magnitude to which the axis corresponds is
written near it and (usually in parentheses) the units used, e.g. time, t ðs), height,
h ðm), or, simply, kI2=m ðS:I:Þ.

Figure 12.2 shows some common kinds of linear axes:

(a) The simplest kind, with a number at every division.
(b) With numerical indications every 5 units and 4 subdivisions between them.
(c) The scale does not start at 0. In this way, the region of interest or the region in

which experimental results exist may be shown in greater detail.
(d) The numerical indications have a common multiplying factor, e.g. �10�7. The

range covered by the axis in this case is between 0 and 29� 10�7 s.
(e) Two different scales are used on the axis. This may be necessary in order to

bring out the details in a region of values (here, between 0 and 6 s). The ‘break’
in the axis must be marked clearly.

For convenience, every subdivision of the graph paper used (usually with mm
subdivisions) corresponds to 1, 2 or 5 units or to the corresponding multiples of a
power of 10, depending on the range of values to be covered. This is done to

Fig. 12.2 Examples of axes
with linear scales
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facilitate marking the points on the graph, as well as in reading numerical values
from it. A scale on which one cm corresponded to, say, 7 units, would be difficult to
use (Fig. 12.3).

Subdivisions of the units in 1/2, 1/4, 1/8 etc. are actually used in scales in inches,
as these are the subdivisions usually found on inch rulers. If years are used as units,
they are usually subdivided in 12 months. Angles and times may be subdivided in
60 min and 60 s.

It is preferable to avoid using multi-digit numbers (e.g. 0.000 01, 0.000 02, or
10 000, 20 000 etc.). This is easily achieved by the suitable choice of units (e.g. mA
or lA instead of A) or the use of a power of 10 as a common multiplying factor
�103; �10�6 etc:
� �

. Some examples of linear scales are given in Figs. 12.4 and
12.5. Figure 12.5 shows the advantage of the suitable choice of the region of values
in the scales, for the best presentation of the measurements.

12.2.2 Logarithmic Scales

Quite often, when a large range of values has to be covered without losing the
details in the region of small values, we use as variable not the magnitude itself.
e.g. x, but its logarithm log x (we usually use the common (decimal) logarithm
log x, while the use of the natural logarithm, ln x, is rarer). For convenience in the

Fig. 12.3 The choice of a scale (1 cm = 7 units) which makes the reading of values off the graph
difficult

Fig. 12.4 Examples of use of various kinds of linear axes
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reading of values off the graph, the subdivisions of the scale as well as the
numerical values marked on the axis are those of x and not those of log x. This is
demonstrated in Fig. 12.6a, where an axis was drawn with the logarithm of f, log f ,
taking values from 1 to 3, while in Fig. 12.6b the same axis is drawn, on which now
the subdivisions and values marked are those of f, which takes values between 1 and
1000, corresponding to the values of log f between 0 and 3. On the axis of
Fig. 12.6b the subdivisions corresponding to the values of 2, 3, … 9, 20, 30, … 90,
200, 300,… 900 are also drawn. It should be noted that, although the logarithm is a
dimensionless magnitude, the numerical value of the logarithm of a physical
quantity depends on the units used in expressing this quantity. For this reason, it is
necessary to state the units used, in parentheses, immediately after the symbol for
the physical quantity, e.g. log f ðHz). Figure 12.7 shows four of the many kinds of
semi-log (one linear and one logarithmic axis) and log-log (both axes logarithmic)
graph paper available. Naturally, on the logarithmic graph paper available, there are
given, whenever possible, more subdivisions than shown in our figures. For
example, the interval between 1 and 2 is often subdivided into tenths, etc.

The choice of the scales to be used in any particular case depends mainly on the
relationship expected to exist between the plotted variables. Thus, semi-log graph
paper is used, apart from the case we have already mentioned in which we wish to

Fig. 12.5 The choice of the suitable range of values in the scales

Fig. 12.6 A logarithmic
scale of three decades (or
three cycles)
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cover a large range of values, also when the relation between two variables is
exponential, as, for example, when it is

y ¼ A e�j x: ð12:1Þ

Then, since it is

ln y ¼ lnA� jx; ð12:2Þ

plotting the natural logarithm of y as a function of x, will result in a linear graph. The
same is true if the common logarithm of y is plotted as a function of x (since it is
log y ¼ ln y= ln 10). A linear relation is desirable, as it is easier to draw a straight line
between the points (x, log y) than it is to draw the corresponding exponential curve.

Fig. 12.7 a, b Three-decade semi-log graph paper, c log-log paper with 3 � 3 decades, d log-log
paper with 5 � 5 decades
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Using log y as variable, we succeed in depicting the large values of y as well as the
small ones. A classic example is the case of the decrease of the activity of a radioactive
sample with time, presented in Fig. 8.2 which we reproduce here (Fig. 12.8).

The mathematical relation between the activity R and the time t is:

RðtÞ ¼ R0e�k t: ð12:3Þ

Plotting log R as a function of time, we have the straight line shown in the figure.

For relationships of the form y ¼ Axn, the use of logarithmic scales for both
variables leads to a linear relation:

log y ¼ logAþ n log x: ð12:4Þ

For example, the Child-Langmuir law for the anode current Ia passing through a
vacuum tube diode is found theoretically to be of the form

Ia ¼ KV3=2
a ; ð12:5Þ

where Va is the anode potential and K is a constant which depends on the geometry
of the diode. Figure 12.9 shows the experimental results of Ia as a function of Va,
plotted using logarithmic scales. The linear relation

log Ia ¼ logK þ 3
2
logVa ð12:6Þ

Fig. 12.8 The variation with time t of the activity R of a radioactive sample. The scale of R is
logarithmic but the corresponding values of R are shown
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is seen to apply for large values of Ia and Va, with the slope of the straight line
actually being equal to 3/2. The deviation from linearity at low currents is due to the
fact that current passes through the diode even when no potential difference is
applied between cathode and anode. The relation is, in practice,

Ia ¼ KðV0 þVaÞ3=2; ð12:7Þ

with V0 ¼ 0:3 V for the diode of Fig. 12.9. If we plot Ia as a function of Va þ 0:3 V,
using logarithmic scales, we will have the linear relation holding over all the range
of values.

Another example is shown in Fig. 12.10, where the periods T of the planets were
plotted as a function of the planets’ distances from the Sun (the semi-major axes of
their elliptic orbits), a, using logarithmic scales. The unit for the distance is the
astronomic unit (1 ua = mean distance of Sun-Earth) and the unit for time is the
year. As a result, the point for Earth is (1, 1). The resulting linear relation verifies
Kepler’s third law, T2 / a3 (the straight line has a slope of 3/2).

A variety of combinations of scales can be used to bring out a certain charac-
teristic of a graph. Examples are shown in Fig. 12.11.

12.2.3 Polar Diagrams

It is often the case that the dependence of one magnitude on another is angular,
rðhÞ. In these cases, it is useful to draw the relation using a polar diagram, such as
that shown in Fig. 12.12. The independent variable is plotted as an angle on a circle

Fig. 12.9 Anode current as a function of anode potential for a vacuum tube diode
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and the dependent variable is given by the corresponding distance from the center
of the diagram.

An example of a polar plot is shown in Fig. 12.13, where the relative luminosity
of an electric bulb has been drawn as a function of the direction, as this is given by
the angle h it forms with the axis of the bulb.

Fig. 12.10 Kepler’s third law. The point for the newly discovered dwarf planet Eris should not be
taken as verifying the law, as it is certain that the law was actually used in order to evaluate its
period from the knowledge of its orbit

Fig. 12.11 The effect of different kinds of scales on a graph or mapping a pig (with
acknowledgements to unknown author)
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Fig. 12.12 The scales of a polar diagram

Fig. 12.13 A polar diagram of the relative luminosity of an electric bulb as a function of
direction, as this is given by the angle h it forms with the axis of the bulb. Point P has co-ordinates
ðh ¼ 115o; Lrel ¼ 8:5Þ
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To give an example, point P shows that the relative luminosity of the bulb in a
direction forminganangleofh ¼ 115o with respect to the upward vertical isLrel ¼ 8:5.

Polar diagrams which have a logarithmic radial scale are sometimes used, in
order to cover a wide range of values without losing the details at low values. An
example of graph paper used in such cases, with 3 cycles of logarithmic scale, is
shown in Fig. 12.14.

12.2.4 Other Matters Relating to the Axes and the Scales
of Graphs

It is sometimes desirable to give in a graph a second scale, which has some
mathematical relationship with the main scale and which gives additional infor-
mation. For example, let us examine the Arrhenius equation

s ¼ s0 eE=kT ; ð12:8Þ

where s0, E and k are constants and T is the absolute temperature. Then, since it is

ln s ¼ ln s0 þ E
k

� �
1
T
; ð12:9Þ

Fig. 12.14 Polar logarithmic graph paper
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Fig. 12.15 The use of an additional auxiliary scale. Apart from the basic scale for 1=T , the scale
for the temperature values T is also given along the upper axis

if we plot log s or ln s as a function of 1=T we will have a straight line (Fig. 12.15).
Apart from the main scale of 1=T , it is useful to also have a scale for T , from which
we can read directly the values of the absolute temperature. In Fig. 12.15 the scale
of the temperature T is given along the top axis. This scale is not, of course, linear.

One more example of a graph with double axes which are mathematically related
is shown in Fig. 12.16. Figure 12.17 shows an example where the second axis
gives some specific values of the independent variable.

In some cases, when using linear scales, the values of the dependent variable may
be too small in a certain region to be clearly visible. In such cases we re-draw the
region of interest in a different scale. Next to this re-drawn section we give the factor
by which the values had to be multiplied in order to reach their new level (e.g.
�10; �100 etc.). Such an example is shown in Fig. 12.18, in which the second
peak was re-drawn at a more sensitive scale in order to make visible details of the
peak. As indicated in the figure, the values were re-drawn having been multiplied by
10. We must be careful here, as some researchers mark on the graph the factor by
which the scale numbers must be multiplied in order to read a value off the graph.

If we wish to compare two different quantities, we may plot both in the same
graph (Fig. 12.19). One axis (usually the x-axis) is common. In general, the other
two axes are drawn, if they are different, on the left-hand-side and on the
right-hand-side. As has been done in Fig. 12.19, the correspondence of curves and
scales is shown by arrows. Alternatively, we might write next to the curves which
one gives y1 and which y2.

More than one series of measurements may be presented in one graph, using
different symbols for the points of each. In Fig. 12.20 the values of the specific heat
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of four solids were drawn as functions of the reduced temperature T=hD, where hD
is the Debye temperature of each solid. The symbol used for each solid is given in
the text box on the graph. In this particular case when using as variable the reduced

Fig. 12.17 The use of an additional auxiliary axis which gives some specific values of the
independent variable

Fig. 12.16 The use of an additional auxiliary axis. b is the ratio of the particle’s speed to the
speed of light in vacuum, c
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Fig. 12.18 Drawing a part of
the graph in a different scale,
to highlight possible details.
The multiplying factor given
should be the factor by which
the values were multiplied in
order to get the curve shown

Fig. 12.19 Plotting, on the
same graph, two different
physical magnitudes, y1 and
y2, having a common scale for
the independent variable (x).
The arrows point towards the
scale to be used with each
curve

Fig. 12.20 The drawing of four series of measurements in one graph. The points give the results
of measurements of the specific heat of four materials as a function of the absolute temperature
T divided by the Debye temperature, hD, characteristic of each material. The distinction of the
series is achieved by using different symbols for the points of each one of them. The values of the
Debye temperature for each material are given in the box in the figure. The continuous curve
shows the theoretical prediction of the Debye theory for the specific heats of solids. When Ct is
plotted as a function of the reduced temperature T=hD, a curve results which is universal for all
solids
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temperature T=hD for each solid, where T is the absolute temperature and hD a
temperature characteristic of the material (the Debye temperature) the values for all
the materials fall on a common, universal, theoretical curve, which is derived in
Debye’s theory of the specific heats of solids. This curve has been drawn in the
figure. In most cases, however, in which this drawing technique is used, different
curves are obtained for different materials or for different experimental conditions,
if these vary from one series of measurements to another.

12.2.5 Legends of the Figure, Labels of the Axes
and the Units of Physical Magnitudes

As a rule, the figure should convey as much information as possible by itself,
without the reader having to resort to the text. The contents of the graph, together
with its legend, should be enough to enable the reader to understand what the figure
describes. The legend of a figure should be informative without being of excessive
size, a rule which was probably not followed in Fig. 12.20. Of course, for the
details, the text is indispensable.

Each axis of a graph should be clearly labeled with the magnitude it records, its
symbol and its units. If the name is too long to be written along the axis, a suitable
symbol may be used, which should be clearly explained in the legend. Examples are
the following:

Increasing number of the measurement, i
Distance, s ðmÞ
Speed, tðm/sÞ
Electric current, I ðlAÞ
Temperature gradient, dT=dx ðK/mÞ
Thermal conductivity, j ðW/m�KÞ
Thermal conductivity/Electrical conductivity, j=rðW�X=KÞ
Differential cross-section, dr=dX ðmbarn/steradÞ
or just symbols: E=k ðKÞ 2Nh2d=jr0 ðJ�K/(s m4ÞÞ or 2Nh2d=jr0 ðS:I:Þ

There are different opinions regarding the way in which the units should be
given. It is of course a rule that the units are written in upright letters
m, s, K, km, W, V,. . .ð Þ, as opposed to the variables, which are symbolized by
italics x; l;m; I;E;V ; dx=dt; . . .ð Þ. There is also the point of view that fraction sla-
shes (solidi) should not be used in stating the units. It is suggested that m s�1 should
be written instead of m/s, Nm2 kg�2 instead of Nm2 kg2 etc. The reason for this is
to avoid confusion when many fraction slashes appear without it being clear which
quantity is divided each time. For example, by the expression N m/s/K/kg it is not
clear that it is meant N m/(s/K/kg) or ðN m/s)/(K/kg) or N (m/s/K)/kg or something
else. The use of fraction slashes is accepted, however, if such uncertainties are
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avoided by the suitable use of parentheses, as, for example, in the case of W/(K/m).
The problem also disappears if we take care for only one slash to appear, as, for
example, in the case of Wm/K. The S.I. system of units has already been presented
in Chap. 5.

According to the Symbols Committee of the Royal Society [1], the symbols and
their units should be written, in tables and graphs, as dimensionless numbers:

Magnitude=Units:

For example, a column of a table or the axis of a graph giving the temperature in
degrees Kelvin must be labeled as T=K. Thus, the number 400 in a table or a graph
means T=K ¼ 400, or T ¼ 400 K. This symbolism, however, presents a problem
when we are dealing with complex quantities. For example, if (God forbid!) the
magnitude

ðStefan-Boltzmann's constantÞ� electric conductivityð Þ

should arise in some theoretical work and we express the Stefan-Boltzmann con-
stant in terms of universal constants, together with their units, we would have the
expression

ðp2=60Þk4�h�3c2rg=Wm�3 K�4 X�1

which might cause some confusion.
Different scientific journals have adopted different notations regarding the pre-

sentation of units. In this book, for tables and graphs, we prefer to write the physical
magnitude and its units separately, with the units given in parentheses, as in the
examples given above.

12.3 The Points

A point x; yð Þ is marked in a graph using a symbol, such as the ones shown in
Fig. 12.21.

The symbol must be large enough to be clearly visible. The same symbol is used
for all the points corresponding to the same series of measurements, unless we wish
to separate a point from the others due to some reason. If there are more than one
series of measurements and their points are not sufficiently separated in the graph,
we use different symbols for the different series of measurements (see, for example,
Fig. 12.20).
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If the errors dx ¼ r�x and dy ¼ r�y in the values of x and y, respectively, are
known, these are marked on the graph, as shown in Fig. 12.22. For the point on the
left in Fig. 12.22, only the value of y has an error. If the error in y is dy ¼ r�y, then
we draw a vertical line which stretches from the point x; yð Þ up and down to the
points x; y� dyð Þ. For the point on the right in the figure, for which there are errors
both in x and in y, the same procedure is followed for the error in x. Drawing the
errors in the graph is important as it affects the form of the curve we will draw in
order to describe the mathematical relationship between x and y, which results from
the experimental values. Two examples of graphs drawn with errors in the mea-
surements x; yð Þ are shown in Fig. 12.23.

Fig. 12.21 Some of the symbols commonly used for denoting points in graphs

Fig. 12.22 Denoting the errors dx ¼ r�x and dy ¼ r�y in the values of x and y in a graph. In the
case of the point on the left, there is an error only in y, while in the case of the point on the right
there are errors in both x and y

Fig. 12.23 Two graphs on which the errors in the values of x and y are indicated. a Errors exist
only for the values of y, b errors exist for the values of both x and y
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12.4 The Curve

Having chosen the axes and marked all the experimental points xi; yið Þ with their
errors in the diagram, we wish to draw the best curve describing the relation yðxÞ.
The tern ‘best curve’ does not have a unique interpretation. Experience has taught
us that mathematical simplicity is one criterion. This, however, cannot mean that a
straight line is always preferable to a parabola and so on. The existence of a
theoretical prediction for the particular experiment is usually the best way out of the
difficulty. Even then, however, the possibility exists that the theoretical curve is not
followed exactly by the experimental points due to errors. For example, a straight
line may not pass through the origin, although theory predicts that it should do so.
Summarizing, we may say that the main factors which determine our choice of the
mathematical expression best describing a series of measurements are:

1. The relation ‘suggested’ by the positions of the points, taking into account their
errors.

2. A theoretically predicted mathematical relation.
3. The simplicity of the mathematical relation.
4. Our experience from similar cases.

We will examine below some issues related to this procedure.
At the start, it should be stressed that the curve does not necessarily have to pass

through all the experimental points (nor even through any of them). This is a
frequent mistake. Two examples of this erroneous practice are shown in Fig. 12.24.
Although the picture presented in the figure in not always impossible to be true, in
the cases when something like this happens, it should be adequately documented.
An example, from outside the physical sciences, is the daily variation of a stock
exchange index. In this case, values between the points have no meaning and the
connection of adjacent points with straight lines is justified, in order that the suc-
cession of values should be clear. In Physics or Chemistry, the recording of the
values of a particular property of the elements as a function of their atomic number,
for example, would justify a graph such as that of Fig. 12.24a. The straight lines
help us follow the succession of points. In general, if the independent variable is
quantized, a plot such as the one in Fig. 12.24a is usually justified.

In general, the curve adjusted to a series of measurements must be as smooth as
possible. This can be seen as another application of Occam’s razor. Deviation from
a straight line or a smooth curve is justified only if there are an adequate number of
reliable experimental points in the region of the deviation, taking into account the
magnitude of the errors. Whenever possible, the curve should pass between the
limits of the errors (see, for example, Fig. 12.25), always remembering that devi-
ations from the real value by one or even more standard deviations are not rare. On
the other hand, we should bear in mind that a point differing by more than about
two standard deviations from the curve should be investigated, in order to decide
whether the point is acceptable or it should be rejected.
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In Fig. 12.25a, a straight line expresses the relation yðxÞ to a satisfactory degree.
In Fig. 12.25b, however, given the systematic behavior of the points as well as the
magnitudes of the errors in y, a straight line is not satisfactory and a curve of the
second degree (parabola) is required.

Theory suggests that the best curve through the experimental points should
cross, on average, only 2 out of 5 error bars. To demonstrate this, we apply the
results of Example 9.5 to the points of graph in Fig. 12.23b. We draw ellipses with
semi-axes equal to r�x and r�y, and centers at the corresponding points ð�x; �yÞ
(Fig. 9.26a). The probability of the real point ðx; y0Þ lying within the corre-
sponding ellipse is 39%. With this in mind, we expect the straight line drawn
between the 11 experimental points (Fig. 9.26b) to pass through 4 of the ellipses. In
fact, it cuts 8. This is evidence that the straight line fit is a good one. We also found
that 87% of the ellipses with semi-axes equal to 2r�x and 2r�y should be intersected
by the straight line. Here, all 2r�x � 2r�y ellipses are crossed by the line (Fig. 12.26).

In programs used in personal computers nowadays, there are large libraries of
mathematical functions which may be fitted to the experimental results. Apart from

Fig. 12.24 Two examples of the wrong plotting of the curve between the experimental points,
when the independent variable is continuous

Fig. 12.25 The adjustment of a curve to a number of experimental points. a We see that, taking
into account the errors in the values of y, a straight line adequately describes the relation yðxÞ. b In
this example, a second degree curve is necessary for the description of yðxÞ
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the common mathematical functions such as polynomials of various degrees,
exponential functions, trigonometric functions etc. and their combinations, there are
specialized functions which are used in specific branches of science, such as
Statistics, optical, dielectric and gamma-ray spectroscopy etc. The fast and expe-
dient fitting of the best curve to the experimental points is, therefore, a matter of
experience, mainly in the use of the suitable programs. Of course, the thing that
cannot be done efficiently by any other method is the preliminary examination of
the point ‘by eye’ in order to check whether there is a problem with some of the
points, which has to be resolved before a curve is fitted.

Example 12.1 [E]

Graph plotting with Excel®

i ti ðsÞ zi ðmÞ dti ðsÞ dzi ðmÞ
1 0 0 0.1 0

2 5 12 0.2 0.5

3 10 55 0.3 4

4 15 100 0.25 8

5 20 200 0.3 10

6 25 305 0.5 15

7 30 380 0.5 15

8 35 430 0.6 20

9 40 485 0.7 25

10 45 490 0.7 30

Fig. 12.26 a The ellipse with center an experimental point and semi-axes equal to the uncertainties
dx ¼ r�x and dy ¼ r�y in �x and �y respectively. The real point corresponding to x and y has a 39%
probability to lie within this ellipse. b The straight line fitted to the experimental points is expected
to cut 39% or approximately 4 of the 11 ellipses such as that of a corresponding to the experimental
points. Instead it cuts 8, a fact that must suggest that the linear fit is a very good one
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A table is given, containing the pairs of experimental results ti and zi of a relation
zðtÞ between the position of a particle and time, together with their respective errors,
dti and dzi.

Create a scatter plot of zðtÞ. Format the graph. Find the best polynomial curve
zðtÞ that fits the experimental points.

Differentiate the curve found, zðtÞ, to obtain the velocity of the particle, tðtÞ.
Differentiate this curve, tðtÞ, to obtain the acceleration of the particle, aðtÞ. Plot the
curves tðtÞ and aðtÞ in the graph of zðtÞ.
We enter the data ti; zðtÞ; dti and dzi in columns A, B, C and D, respectively.
Highlight columns A and B. Open the Insert window and from Charts select
Insert Scatter (X, Y) or Bubble Chart. A graph now appears, which is shown in
the figure below. We will format this graph.

Pressing the þ key that appears when we click on the top right hand side of the
graph’s box opens the Chart Elements dialog box. We choose

Error Bars > More Options > Format Error Bars > Error Bar Options
In Vertical Bar Options, we select Direction: Both, End Style: Cap, Error

Amount: Custom. Then,
Specify Values > Positive Error Values and Negative Error Values

type = Sheet1!$D$4:$D$13
Press OK. The vertical error bars appear in the figure at each point.
Ticking on a horizontal error bar opens a dialog box in which we select

Direction: Both, End Style: Cap, Error Amount: Custom. Then,
Specify Values > Positive Error Values and Negative Error Values

type = Sheet1!$C$4:$C$13
Press OK. The horizontal error bars also appear in the figure at each point.
We will fit a polynomial curve to the points.
Pressing the þ key opens the Chart Elements dialog box. We choose
Error Bars > More Options > Trent Line Options > Polynomial: Order 4

and Display Equation on chart
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The equation of the curve fitted is:

zðtÞ ¼ 3:3741� 4:355 tþ 1:0543 t2 � 0:0177 t3 þ 4� 10�5 t4 ðinm for t in sÞ:

Double-clicking on the curve opens the Format Trendline, Trendline Options
window. For Line, we choose: Solid Line, Color: Black, Width: 1 pt, Dash Line:
solid line.

We will now plot the curves for tðtÞ and aðtÞ in the graph.
Differentiating with respect to time, we have the speed

tðtÞ ¼ �4:355 þ 2:1086 t � 0:0531 t2 þ 1:6� 10�4 t3 inm=s for t in sð Þ:

Differentiating with respect to time, we have the acceleration

aðtÞ ¼ 2:1086� 0:1062 tþ 4:8� 10�4 t2 inm=s2for t in s
� �

:

We label an empty column, say E(Y) as v (m/s). In cell E4 we type
(−4.355 + 2.1086 * A1 − 0.0531 * A1^2 + 0.00016 * A1^3) * 10

and press ENTER. The factor of 10 is used since we are going to plot zðtÞ; tðtÞ and
aðtÞ in the same graph, using a common axis, and we want to do this using
comparable numbers, for easier readability. We Fill Down from E4 to E13.These
cells now contain the values of 10tðtÞ.

We label an empty column, say F(Y) as a (m/s2). In cell F4 we type
(2.1086 − 0.1062 * A1 + 0.00048 * A1^2) * 100

and press ENTER. The factor 100 serves the same purpose as the factor 10 for the
velocity, as explained above. We Fill Down from F4 to F13. These cells now
contain the values of 100aðtÞ.

We highlight cells A4 to A13 and E4 to E13. In Insert, Charts we chose the
option smooth line plot without points. This produces a graph of tðtÞ.

We highlight cells A4 to A13 and F4 to F13. In Insert, Charts we chose the
option smooth line plot without points. This produces a graph of aðtÞ.

We Cut the graph tðtÞ and Paste it on the graph aðtÞ. We then Cut the graph zðtÞ
and Paste it on the graph of aðtÞ and tðtÞ.

We format the graph containing zðtÞ; tðtÞ and aðtÞ by changing the colors to
black etc., as described below. In order to write something on the plot, we open
Insert and insert a Text Box. We write the text in the box and then move it to the
appropriate position.

We write z; 10t and 100a near the corresponding curves, in order to identify
them.

We click and select the numbers on the X-axis opening Chart Tools. In Format
we open Text Fill and select black. We do the same with the Y-scale.

We click anywhere in the area of the numbers of the X-axis. This opens
Chart Tools. Open the Format window. In the top left corner of the screen select
Horizontal (Value) Axis. This opens the Format Axis window for the horizontal
axis. In Line select Solid Line, Color black, Width 0.75 pt. In the same window,
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click the icon showing a histogram. Open Axis Options and select Bounds,
Minimum 0 and Maximum 50. For Units, we select Major 5 and Minor 1. Open
Tick Marks and select Major Type, Outside and Minor Type, Outside.

Repeat the same procedure for the Vertical (Value) Axis. In this case select
Bounds,Minimum −200 andMaximum 600. For Units, we select Major 100 and
Minor 20.

We click anywhere in the plot area. This opens Chart Tools. Open the Format
window. In the top left corner of the screen select Horizontal (Value) Axis Major
Gridlines. This opens the Format Axis window for the horizontal major gridlines.
Select Solid Line, Color black and Width 0.75 pt. We now open the Horizontal
(Value) Axis Minor Gridlines. This opens the Format Axis window for the
horizontal minor gridlines. Select Solid Line, Color gray and Width 0.5 pt.

We repeat the same procedure for the vertical gridlines.
To white out the background of lettering so that they are easy to read, we

double-click on the area of the X-axis numbers. This opens the Format Axis
window. Clicking on the first icon, we select Fill, Pattern Fill, Foreground white
and Background white.

To white out the background of text in the plot area, we right-click on the text. In
the window that opens we select Format Object. Clicking on the first icon, we
select Fill, Pattern Fill, Foreground white and Background white.

To remove the border line around the plot, we right-click on the plot area and
open the Format Chart Area window. We click on the first icon in
Chart Options. We select No Line.

The final result is shown in the figure below.

Example 12.2 [O]

Graph plotting with Origin®

A table is given, containing the pairs of experimental results ti and zi of a relation
zðtÞ between the position of a particle and time, together with their respective errors,
dti and dzi.
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i ti ðsÞ zi ðmÞ d ti ðsÞ d zi ðmÞ
1 0 0 0.1 0

2 5 12 0.2 0.5

3 10 55 0.3 4

4 15 100 0.25 8

5 20 200 0.3 10

6 25 305 0.5 15

7 30 380 0.5 15

8 35 430 0.6 20

9 40 485 0.7 25

10 45 490 0.7 30

Create a scatter plot of zðtÞ. Format the graph. Find the best polynomial curve zðtÞ
that fits the experimental points.

Differentiate the curve found, zðtÞ, to obtain the velocity of the particle, tðtÞ.
Differentiate this curve, tðtÞ, to obtain the acceleration of the particle, aðtÞ. Plot the
curves tðtÞ and aðtÞ in the graph of zðtÞ.
We enter the data ti; zðtÞ; dti and dzi in columns A(X), B(Y), C(Y) and D(Y),
respectively. Right-click on C(Y). Then

Set As > X Error
The label of the column now becomes C(xEr±). This indicates that the column

contains the errors in the values of X, i.e. in t.
Right-click on D(Y). Then
Set As > Y Error
The label of the column now becomes D(yEr±). This indicates that the column

contains the errors in the values of Y, i.e. in z.
Highlight columns A, B, C and D. Then
Plot > Symbol > Scatter
The plot shown in the figure below appears.

We will format this graph.
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We will fit a polynomial curve to the points. While in the plot environment, we
follow the path

Analysis > Fitting > Nonlinear Curve Fit > Open Dialog…
In the window that opens, we select
Settings > Function Selection > Category set to Polynomial > Function set

to Poly4
This will fit a polynomial of the fourth degree to the experimental points. Press

Fit. The fitted curve appears on the graph. The equation of the curve fitted is:

zðtÞ ¼ 3:34� 4:312 tþ 1:0437 t2 � 0:01756 t3 þ 3:946� 10�5 t4 inm for t in sð Þ:

Differentiating with respect to time, we have the speed

tðtÞ ¼ �4:312 þ 2:0874 t � 0:05268 t2 þ 1:3784� 10�4 t3 inm=s for t in sð Þ:

Differentiating with respect to time, we have the acceleration

aðtÞ ¼ 2:0874� 0:10536 tþ 4:135� 10�4 t2 inm=s2for t in s
� �

:

We will now plot the curves for tðtÞ and aðtÞ in the graph.
In the data sheet (Book1) we highlight an empty column, say E(Y), which we

label as v (m/s). Then
Column > Set Column Values
and in the dialog box that opens we type
−4.312 + 2.0874 * col(A) − 0.05268 * (col(A))^2 + 0.00013784 * (col(A))^3
Pressing OK fills column E with the values of tðtÞ.
In the data sheet (Book1) we highlight an empty column, say F(Y), which we

label as a (m/s). Then
Column > Set Column Values
and in the dialog box that opens we type
2.0874 − 0.10536 * col(A) + 0.0004135 * (col(A))^2
Pressing OK fills column F with the values of aðtÞ.
We will plot these values in the graph of zðtÞ. Before we do so, however, we

want to bring the values to be plotted in the same range as those of zðtÞ. To achieve
this, we fill column G with the values of 10tðtÞ and column H with the values of
100aðtÞ.

Returning to the graph environment (Window, Graph1), we right-click on the
number at the top left hand side of the page and then we click on Layer
Contents… . In the window that opens, we highlight the line corresponding to
column G by clicking on any point of the line. Then, pressing the arrow ⟶, we
include column G in the list on the right, which shows the columns plotted in the
graph. We repeat for column H. Then press Plot Setup… . The graph appears, now
containing the scatter plots of 10tðtÞ and 100aðtÞ.
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We will change the plots of 10tðtÞ and 100aðtÞ from scatter to line plots. To do
this we double-click on one of the points, opening the Plot Details—Plot Properties
and in the Plot Type select Line. We do this for both the plots 10tðtÞ and 100aðtÞ.

We double-click on each of the three curves in turn and change the line width to
1.5 and the color to black.

To change the ranges of the scales, we double-click on one of the axes. In the
window that opens we set the Horizontal scale From 0 To 50 and the Vertical
scale From −200 To 600.

In the same window, we open Tick Labels. For the Left and Bottom axes we
tick the Show box.

In the same window, we open Grids. For Vertical, Major Grid Lines, tick the
Show box and select Color to be Black, Style to be Solid and Thickness to be 0.5.
For Minor Grid Lines, we tick the Show box and select Color to be Black, Style
to be Solid and Thickness to be 0.3. In Additional Lines tick Y = 0. For
Horizontal, Major Grid Lines, we tick the Show box and select Color to be
Black, Style to be Solid and Thickness to be 0.5. For Minor Grid Lines, we tick
the Show box and select Color to be Black, Style to be Solid and Thickness to be
0.3. In Additional Lines tick Y = 0.

In the same window, we open Lines and Ticks.
For Bottom, we tick the Show Line and Ticks box and select: for Line we tick

the Show box, Color to be Black, Thickness 1.5 and Axis Position Bottom. For
Major Ticks we select Out. For Minor Ticks we select Out. For Top we tick the
Show Line and Ticks box and the Use Same Options for Bottom and Top box.
For Left we use same settings as Bottom. For Right we tick the Show Line and
Ticks box and the Use Same Options for Left and Right box. Press OK.

We double click on each of the three lines in turn and set for each Line: Connect
to be Straight, Style to be Solid, Width to be 1 and Color to be Black.

We double click on the X label and write t (s). We double click on the Y axis and
write z (m) or 10t (m/s) or 100a (m/s2) . Identify the three curves by writing z, 10t
and 100a near the corresponding curve.

The final result is shown in the figure below.
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Example 12.3 [P]

Graph plotting with Python
A table is given, containing the pairs of experimental results ti and zi of a relation
zðtÞ between the position of a particle and time, together with their respective errors,
dti and dzi.

Create a scatter plot of zðtÞ. Format the graph. Find the best polynomial curve
zðtÞ that fits the experimental points.

Differentiate the curve found, zðtÞ, to obtain the velocity of the particle, tðtÞ.
Differentiate this curve, tðtÞ, to obtain the acceleration of the particle, aðtÞ. Plot the
curves tðtÞ and aðtÞ in the graph of zðtÞ.

i ti ðsÞ zi ðmÞ d ti ðsÞ d zi ðmÞ
1 0 0 0.1 0

2 5 12 0.2 0.5

3 10 55 0.3 4

4 15 100 0.25 8

5 20 200 0.3 10

6 25 305 0.5 15

7 30 380 0.5 15

8 35 430 0.6 20

9 40 485 0.7 25

10 45 490 0.7 30

As usual, we will import the numpy and matplotlib modules, and then entering
the experimental data into vectors t and z, and the corresponding error values into
vectors errt and errz.

import numpy as np

import matplotlib.pyplot as plt

t = np.array([0, 5, 10, 15, 20, 25, 30, 35, 40, 45])

z = np.array([0, 12, 55, 100, 200, 305, 380, 430, 485, 490])

errt = np.array([0.1, 0.2, 0.3, 0.25, 0.3, 0.5, 0.5, 0.6, 0.7, 0.7])

errz = np.array([0, 0.5, 4, 8, 10, 15, 15, 20, 25, 30])

We use the errorbar function of matplotlib to produce a scatter plot with error bars:

plt.errorbar(t, z, xerr=errt, yerr=errz, fmt='o', color='b')

plt.xlim(0, 50)

plt.ylim(-200, 600)

plt.xlabel(''t (s)'')

plt.ylabel(''z (m) or 10t (m/s) or 100a (m/s^2)''

plt.grid(True)
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The fmt = ‘o’ option indicates that the experimental points will be drawn as
small circles on the scatter plot. Other available markers include ‘s’ for a square, ‘*’
for a star, ‘D’ for a diamond, and ‘1’, ‘2’, ‘3’, ‘4’ for a triangle (down-, up-, left- or
right-oriented respectively). A complete list of markers can be found on http://
matplotlib.org/api/markers_api.html. These markers can also be used with the plot
and scatter commands. The color parameter sets the colour of the points: ‘b’ is
shorthand for blue, ‘r’ for red, ‘g’ for green, ‘k’ for black etc. A complete list of
colours available for use in matplotlib graphs can be found on http://matplotlib.org/
api/colors_api.html.

We then use the least-squares method to fit a fourth degree polynomial to the
experimental data, as follows:

fit = np.polyfit(t, z, 4)

p = np.poly1d(fit)

In order to draw this polynomial as a curve, we create a series of 200 points
between min(t) and max(t) using the linspace command from numpy, and then use
the plot command. The third parameter (‘-’) to the plot command indicates that the
points should be linked (to form a smooth curve).

xp = np.linspace(min(t), max(t), 200)

plt.plot(xp, p(xp), '-', color=''red'')

The numpy polynomial object supports the deriv function that calculates derivatives
of the polynomial. We store the velocity (first derivative) and acceleration (second
derivative) polynomials in objects v and a as follows:

v = p.deriv(1)

a = p.deriv(2)

Using the same method as above, we can plot 10t and 100a on the graph, using the
following commands:

plt.plot(xp, 10*v(xp), '-', color=''blue'')

plt.plot(xp, 100*a(xp), '-', color=''black'')

Our graph is ready: to see it on the screen, or export it as an image file, we issue the
show() command:

plt.show()
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Example 12.4 [R]

Graph plotting with R
A table is given, containing the pairs of experimental results ti and zi of a relation
zðtÞ between the position of a particle and time, together with their respective errors,
dti and dzi.

i ti ðsÞ zi ðmÞ dti ðsÞ dzi ðmÞ
1 0 0 0.1 0

2 5 12 0.2 0.5

3 10 55 0.3 4

4 15 100 0.25 8

5 20 200 0.3 10

6 25 305 0.5 15

7 30 380 0.5 15

8 35 430 0.6 20

9 40 485 0.7 25

10 45 490 0.7 30

Create a scatter plot of zðtÞ. Format the graph. Find the best polynomial curve zðtÞ
that fits the experimental points.

Differentiate the curve found, zðtÞ, to obtain the velocity of the particle, tðtÞ.
Differentiate this curve, tðtÞ, to obtain the acceleration of the particle, aðtÞ. Plot the
curves tðtÞ and aðtÞ in the graph of zðtÞ.
We first create the scatter plot of the experimental points. We enter the vectors for t,
z and their errors:

# t and z vectors

t <- c(0, 5, 10, 15, 20, 25, 30, 35, 40, 45)

z <- c(0, 12, 55, 100, 200, 305, 380, 430, 485, 490)
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# errors in t and z

errt <- c(0.1, 0.2, 0.3, 0.25, 0.3, 0.5, 0.5, 0.6, 0.7, 0.7)

errz <- c(0, 0.5, 4, 8, 10, 15, 15, 20, 25, 30)

#scatter plot of data with x and y axes labels, lengths and grid

plot(t, z, pch=20, xlab=''t (s)'', ylab=''z (m)'', xlim=c(0, 50),

ylim=c(0, 600), grid())

# add t error bars

arrows(t-errt, z, t+errt, z, length=0.02, angle=90, code=3)

# add z error bars

arrows(t, z-errz, t, z+errz, length=0.02, angle=90, code=3)

# ENTER returns the scatter plot

We fit to the points a least-squares polynomial of the fourth degree:

# Least-squares curve fit

> nls(z*a0+a1*t+a2*t^2+a3*t^3+a4*t^4)

Nonlinear regression model

model: z*a0+a1*t+a2*t^2+a3*t^3+a4*t^4

data: parent.frame()

a0 a1 a2 a3 a4

3.374e+00 -4.355e+00 1.054e+00 -1.774e-02 3.986e-05

residual sum-of-squares: 751.5

Number of iterations to convergence: 1

Achieved convergence tolerance: 5.72e-07

The equation of the curve fitted is:

zðtÞ ¼ 3:374� 4:355 tþ 1:054 t2 � 0:01774 t3 þ 3:986� 10�5 t4 inm for t in sð Þ:
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Differentiating with respect to time, we have the speed

tðtÞ ¼ �4:355 þ 2:108 t � 0:05322 t2 þ 1:5944� 10�4 t3 inm=s for t in sð Þ:

Differentiating with respect to time, we have the acceleration

aðtÞ ¼ 2:108� 0:10644 tþ 4:7832� 10�4 t2 inm=s2for t in s
� �

:

We will now plot the curves for tðtÞ and aðtÞ in the graph. We first re-plot the
curve z(t) with the z-axis taking values between −200 and 600. To enable easy
reading, we will plot 10t and 100a on the graph. We also change the Y-axis label to
‘z (m) or 10t (m/s) or 100a (m/s2)’.

# Plot the curve z(t):

curve(3.374-4.355*x+1.054*x^2-0.01774*x^3

+3.986e-05*x^4, from=0, to=50, add=T)

# add the curves for 10t and 100a

curve(-43.55+21.08*x-0.5322*x^2+0.001594*x^3, from=0, to=50, add=T)

curve(210.8-10.644*x+0.04783*x^2, from=0, to=50, add=T)

Label the curve for z and the two curves for 10t and 100a:

# add labels to the curves

text(35, 500, ''z'', cex=1)

text(30, 200, ''10t'', cex=1)
text(25, 20, ''100a'', cex=1)

The final graph is shown below
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Example 12.5 [E]

Eight results of measurements of the quantity Y(x) are given in the table below.
Using Excel©, create a graph showing the measurements and the best parabolic
curve between them.

i 1 2 3 4 5 6 7 8

x 1.0 1.5 3.0 4.5 6.0 7.5 9.0 10.5

Y ± dY 0.5 ± 0.3 2.1 ± 0.5 10 ± 2 17 ± 2 32 ± 4 61 ± 5 70 ± 6 99 ± 7

We enter x, Y and dY in columns A, B and C, respectively. To plot Y(x), we
highlight cells A1–A8 and B1–B8 and open the Insert window. We choose scatter
plot. We left-click at the top right corner of the plot and open þ . We open Error
Bars, More Options, Format Error Bars. Double-click at a point near and to the
left or the right of a point of the plot, in order to open the Horizontal Errors
window. In Format Error Bars > Error Bar Options we open . We select
Line > No Line. We double-click at a point near and above or below a point of the
plot, we open the Vertical Errors window. In Format Error Bars > Error Bar
Options we open . We select Line > Solid Line, Color black and Width 0.75
pt. We open Vertical Error Bar. We select Direction Both, End Style Cap,
Error Amount Custom. Clicking Specify Value will open the window Custom
Error Bars. In both Positive Error Value and Negative Error Value
type = Sheet1!$C$1:$C$8. We press OK.

We will now fit the best parabola to the experimental points. We press þ ,
Trendline, More Options. In , Line, we select Solid Line, Color black, Width
1.5 pt, Dash Type continuous line. We open and select Polynomial Order 2.
Also, select Forecast Forward 1 period and Backward 1 period. Finally, click the
box Display Equation on Chart. Left-click on the straight line present in the plot and
delete it. The graph shown on the left below is produced.

We will format this graph.
We delete the Chart Title text box. We click anywhere in the area of the

numbers of the X-axis. This opens Chart Tools. Open the Format window. In the
top left corner of the screen select Horizontal (Value) Axis. This opens the Format
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Axis window for the horizontal axis. In Line select Solid Line, Color black,Width
0.75 pt, Dash Type continuous. In the same window, click the icon . Open Axis
Options and select Bounds, Minimum 0 and Maximum 12. For Units, we select
Major 5 and Minor 1. Open Tick Marks and select Major Type, Outside and
Minor Type, Outside.

Repeat the same procedure for the Vertical (Value) Axis. In this case select
Bounds, Minimum –20 and Maximum 140. For Units, we select Major 20 and
Minor 10.

We click anywhere in the plot area. This opens Chart Tools. Open the Format
window. In the top left corner of the screen select Horizontal (Value) Axis Major
Gridlines. This opens the Format Axis window for the horizontal major gridlines.
Select , Solid Line, Color gray and Width 0.5 pt. We now open the Horizontal
(Value) Axis Minor Gridlines. This opens the Format Axis window for the
horizontal minor gridlines. Select Solid Line, Color gray and Width 0.5 pt.

We repeat the same procedure for the vertical gridlines.
To insert axis titles we open þ , Axis Titles. For the X-Axis title we type x. For

the Y-Axis title we type Y. In Format Axis Title > Text Options > Text Fill
select Solid fill color black. Repeat for the Y-Axis, typing y.

We left-click on the equation of the parabola and change the lettering to Bold
and Size 11 pts.

The final result is that shown in the right-hand-side figure above.

Example 12.6 [O]

Eight results of measurements of the quantity Y(x) are given in the table below.
Using Origin©, create a graph showing the measurements and the best parabolic
curve between them.

i 1 2 3 4 5 6 7 8

x 1.0 1.5 3.0 4.5 6.0 7.5 9.0 10.5

Y ± dY 0.5 ± 0.3 2.1 ± 0.5 10 ± 2 17 ± 2 32 ± 4 61 ± 5 70 ± 6 99 ± 7

We enter the data x, Y and dY in columns A, B and C respectively. Highlight
column C. Right-click on C. Then

Set As > Y Error
Highlight columns A, B and C. Then
Plot > Symbol > Scatter
A plot is produced. We will fit a parabola to the points.
Analysis > Fitting > Polynomial Fit > Open Dialog…
Select Polynomial of Order 2. On pressing OK the graph shown in the figure

on the left below is produced. It is seen that the parabola
Y ¼ ð�0:95534� 1:00945Þþ ð0:65678� 0:95894Þxþð0:84973� 0:11805Þx2

We will improve the appearance of the graph.
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1. We delete the two text boxes given in the figure.
2. We change the thickness of the line by double-clicking on it and changing

Width from 0.5 to 1. We change the color of the line from red to black.
3. We double-click on a point and change the shape and size of the points from

square and 9 pts to circular and 5 points.
4. We change the labels of the axes by double-clicking on them and writing x in

place of A and Y in place of B. We use the default font of Arial 22 pts.
5. We change the Horizontal x axis by double-clicking on it. We set the Scale

from 0 to 12, Major Ticks Value 5 and Minor Ticks Count 4.
6. We change the Vertical Y axis by double-clicking on it. We set the Scale from 0

to 120, Major Ticks Value 50 and Minor Ticks Count 4.
7. We may, if we wish, write the equation of the best fit parabola on the graph.

The result is shown in the figure on the right above.

Example 12.7 [P]

Eight results of measurements of the quantity Y(x) are given in the table below.
Using Python, create a graph showing the measurements and the best parabolic
curve between them.
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i 1 2 3 4 5 6 7 8

x 1.0 1.5 3.0 4.5 6.0 7.5 9.0 10.5

Y ± dY 0.5 ± 0.3 2.1 ± 0.5 10 ± 2 17 ± 2 32 ± 4 61 ± 5 70 ± 6 99 ± 7

import numpy as np

import matplotlib.pyplot as plt

# Enter the values of x and Y:

x = np.array([1, 1.5, 3, 4.5, 6, 7.5, 9, 10.5])

Y = np.array([0.5, 2.1, 10, 17, 32, 61, 70, 99])

# Enter the errors in Y:

errx = np.array([0, 0, 0, 0, 0, 0, 0, 0])

errY = np.array([0.3, 0.5, 2, 2, 4, 5, 6, 7])

# Production of the scatter plot of data with linear axes and grid:

plt.errorbar(x, Y, xerr=errx, yerr=errY, fmt='o', color='b')

plt.xlim(0, 12) # set the x-axis range of values

plt.ylim(0, 120) # set the Y-axis range of values

plt.xlabel(''x'') # set the x-axis label

plt.ylabel(''Y'') # set the Y-axis label

plt.grid(True)

# Least-squares curve fit (parabola)

fit = np.polyfit(x, Y, 2)

p = np.poly1d(fit)

xp = np.linspace(min(x), max(x), 200)

# Plot result:

plt.plot(xp, p(xp), '-', color=''black'')

plt.show()

The plot produced is shown here.
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Example 12.8 [R]

Eight results of measurements of the quantity Y(x) are given in the table below.
Using R, create a graph showing the measurements and the best parabolic curve
between them.

i 1 2 3 4 5 6 7 8

x 1.0 1.5 3.0 4.5 6.0 7.5 9.0 10.5

Y ± dY 0.5 ± 0.3 2.1 ± 0.5 10 ± 2 17 ± 2 32 ± 4 61 ± 5 70 ± 6 99 ± 7

We first create the scatter plot of the experimental points. We enter the vectors for x,
Y and dY:

# x, Y and errY vectors:

x <- c(1.0, 1.5, 3.0, 4.5, 6.0, 7.5, 9.0, 10.5)

Y <- c(0.5, 2.1, 10, 17, 32, 61, 70, 99)

errY <- c(0.3, 0.5, 2, 2, 4, 5, 6, 7)

#scatter plot of data with x and Y axes labels, lengths and grid:

plot(x, Y, pch=20, xlab=''x'', ylab=''Y'', xlim=c(0, 12), ylim=c(0, 120), grid

())

# add Y error bars

arrows(x, Y-errY, x, Y+errY, length=0.02, angle=90, code=3)

# ENTER returns the scatter plot

The scatter plot is shown below on the left.

We fit to the points a least-squares parabola:

# Least-squares curve fit

> nls(Y*a0+a1*x+a2*x^2)

We add the least-squares curve to the graph:

# plot least-squares curve

curve(-2.187+1.493*x+0.775*x^2, from=0, to=12, add=T)

The final graph is shown above on the right.
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Example 12.9 [O]

Plot 3 turns of the Archimedean spiral, r ¼ h, in polar coordinates.

We will give the angle h in degrees but the program will evaluate r with h in
radians. For 3 turns, we therefore need values of h between 0 and
3� 360o ¼ 1080o. We will use 0� h� 1200o.

To plot the graph, we act as follows:
Values of column A. Highlight column A

Column > Set Column Values

and enter (i − 1) for i between 1 and 1201. Press OK.
Values of column B. Highlight column B
Column > Set Column Values
and enter col(A) * 2 * pi/360 for i between 1 and 1201. Press OK.
Highlight both columns A and B. Then,

Plot > Specialized > Plot theta(X) r(Y)

The polar plot of r ¼ h appears.
We will improve the appearance of the graph.
We delete the text box containing B by clicking on it and pressing Delete.
We increase the thickness of the line in the graph by double-clicking on them

and changing Width from 0.5 to 1.
On the r scale, we delete B. Using the Text Tool T we write r in italics and

size 22.
For the h scale, using the Arrow Tool we draw an arrow in the region between 0

and 30 degrees. If we wish, we may change the size, shape or color of the arrow by
double-clicking on it and opening the appropriate window. Changing the font to
Arial Greek we write h next to the arrow.

We export the figure by using
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File > Export Graphs > Open Dialog…

naming the file and selecting the directory in which we wish to save it.

The ease with which we can fit a straight line to the points for which a linear
relation yðxÞ holds, makes it desirable to reduce other mathematical expressions to
linear. We have already seen that an exponential relation

RðtÞ ¼ R0 e�k t ð12:10Þ

may be reduced to a linear by the transformation

y � lnR; a � lnRo; x � t; ð12:11Þ

when we have

y ¼ a� kx ð12:12Þ

which is a linear relation. We may then draw, even by hand, a straight line between
the points x; yð Þ. The intercept of the line with the y-axis gives a and so also
R0 ¼ ea, while the slope of the line gives �k. [It should be noted that this pre-
supposes the use of natural logarithms in the plot, as required by Eq. (12.11). The
determination of k from the slope of the straight line when common logarithms are
used will be described below.]

Many common mathematical relations may be reduced to linear by a suitable
change of variables. The more common of these cases are given in Table 12.1.

Table 12.1 Examples of variable transformations that reduce non-linear relations to linear

# Non-linear relation New variables Resulting linear relation

x y

1 s ¼ s0 þ 1
2c t

2 t2 s y ¼ s0 þ 1
2cx

2 s ¼ t0tþ 1
2c t

2 t s
t y ¼ t0 þ 1

2cx

3 V ¼ � k
r

1
r

V y ¼ �kx

4 Y ¼ 1
aþ bX

X 1
Y

y ¼ aþ bx

5 F ¼ k
r2

1
r2

F y ¼ kx

6 t ¼ k rn log r log t y ¼ log kþ nx

7 N ¼ N0e�k t t lnN y ¼ lnN0 � kx

t logN y ¼ logN0 � ðk log eÞ x
8 Y ¼ abcX X logY y ¼ log aþðc log bÞx
9 Y ¼ abcX þ d X logðY � dÞ y ¼ log aþðc log bÞx
10 Y ¼ aXb logX logY y ¼ log aþ bx

11 Y ¼ aXb þ d logX logðY � dÞ y ¼ log aþ bx

12 1
s þ 1

s0 ¼ 1
f

1
s0

1
s y ¼ 1

f � x
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Example 12.10 [E]

The activity of an isotope at t ¼ 0 is R0 ¼ 6350 cpm, ignoring errors. The mean
lifetime of the isotope is 1=k ¼ 13.2 min. Plot a graph of the expected activity RðtÞ
of the isotope up to t ¼ 150 min. Use a logarithmic scale for R.

We will use the relation RðtÞ ¼ R0e�kt. We will evaluate RðtÞ for 0� t� 150 min in
steps of 1 min. The values of t will be stored in column A, while the corresponding
values of RðtÞ will be stored in column B.

Evaluation of t values: Type 0 in cell A1. In cell A2 type = A1 + 1. After
ENTER, we fill down from cell A2 to cell A151. Cells A1 to A151 now contain the
numbers 0 to 150.

In cell B1 we type = 6350 * exp(−A1/13.2). After ENTER, we fill down from
B1 to B151. Cells B1 to B151 now contain the values of R(t) for 0� t� 150 min in
steps of 1 min.

Highlight columns A and B and through Insert select the Scatter smooth line
plot. Pressing ENTER results in the graph shown on the left, below.

We delete the text box for the Chart Title. We double-click on the Y-Axis and
open the Format Axis window. In Axis Options, we click the Logarithmic
Base 10 box.

We format the plot in the way described in previous examples so that, finally, we
have the graph shown on the right above.

Example 12.11 [O]

The activity of an isotope at t ¼ 0 is R0 ¼ 6350 cpm, ignoring errors. The mean
lifetime of the isotope is 1=k ¼ 13:2 min. Plot a graph of the expected activity RðtÞ
of the isotope up to t ¼ 150 min. Use a logarithmic scale for R.

We will use the relation RðtÞ ¼ R0e�kt. We will evaluate RðtÞ for 0� t� 150 min in
steps of 1 min. The values of t will be stored in column A, while the corresponding
values of RðtÞ will be stored in column B.

Evaluation of t values: Highlight column A. Then

Column > Set Column Values
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In the window that opens we type i − 1 for i from 1 to 151. We press OK. The
values of t in min are entered in column A.

Evaluation of R values: Highlight column B. Then,

Column > Set Column Values

In the window that opens we type 6350 * exp(−col(A)/13.2) for i from 1 to 151.
We press OK. The values of RðtÞ in cpm are entered in column B.

We now plot RðtÞ. Highlight columns A and B. Then

Plot > Symbol > Scatter

The graph shown in the figure on the left below appears.

We will improve the appearance of the graph.

1. We delete the two text box given in the figure.
2. We change the thickness of the line by double-clicking on it and changing

Width from 0.5 to 1.
3. We change the labels of the axes by double-clicking on them and writing t (min)

in place of A and R (c.p.m.) in place of B. We use the default font of Arial 22
pts.

4. We change the Horizontal t axis by double-clicking on it. We set the Scale
from 0 to 160, Major Ticks Value 50 and Minor Ticks Count 4.

5. We change the Vertical R axis by double-clicking on it. We set the Scale from
0.1 to 10 000, Type Log10. Major Ticks and Minor Ticks are set by the
program to 1 and 8 respectively.

6. It is of great assistance in reading values off the graph to have the grid lines
drawn. This is particularly true when one or both the axes are logarithmic. We
will now draw the grid lines:

i. We double click on the t axis, thus opening the X Axis window. Then,
having opened Horizontal, Grids, set
Major Grid Lines: Tick Show, Color Black, Style Solid, Thickness 0.5
Minor Grid Lines: Tick Show, Color Black, Style Solid, Thickness 0.3.
Then,
Vertical, Grids, set the same as for Horizontal, Grids.
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ii. We open the window for Line and Ticks.

Bottom: Tick Show Line and Ticks.

Line: Tick Show, Color Black, Thickness 1.5.
Major Ticks: Style Out.
Minor Ticks: Style Out.

Top: Tick Show Line and Ticks.

Line: Tick Show, Color Black, Thickness 1.5.
Major Ticks: Style In.
Minor Ticks: Style In.

Left: Same as Bottom.
Right: Same as Top.

Press OK.
The result is shown in the figure on the right above.

Example 12.12 [P]

The activity of an isotope at t ¼ 0 is R0 ¼ 6350 cpm, ignoring errors. The mean
lifetime of the isotope is 1=k ¼ 13:2 min. Plot a graph of the expected activity RðtÞ
of the isotope up to t ¼ 150 min. Use a logarithmic scale for R.

We will use the relation RðtÞ ¼ R0e�kt. We will evaluate RðtÞ for 0� t� 150 min in
steps of 1 min. We first plot R(t) with linear scales:

from __future__ import division

import numpy as np

import matplotlib.pyplot as plt

t = np.arange(0, 151)

R = 6350 * np.exp(-t/13.2)

plt.scatter(t, R)

plt.xlim(0, 150)

plt.ylim(0, 7000)

plt.xlabel(''t (min)'')

plt.ylabel(''R (cpm)'')

plt.grid(True)

plt.show()

We then plot R(t) with a logarithmic scale for R (the y axis):

plt.scatter(t, R)

plt.yscale('log')

plt.xlim(0, 150)

plt.ylim(0.1, 10000)

plt.xlabel(''t (min)'')
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plt.ylabel(''R (cpm)'')

plt.grid(True)

plt.show()

The following figure shows the graph with linear scales (left) and the graph with
logarithmic R scale (right).

Example 12.13 [R]

The activity of an isotope at t ¼ 0 is R0 ¼ 6350 cpm, ignoring errors. The mean
lifetime of the isotope is 1=k ¼ 13.2 min. Plot a graph of the expected activity RðtÞ
of the isotope up to t ¼ 150 min. Use a logarithmic scale for R.

We will use the relation RðtÞ ¼ R0e�kt. We will evaluate RðtÞ for 0� t� 150 min in
steps of 1 min. We first plot R(t) with linear scales:

> # scatter plot with linear scales:

> t <- seq(0, 150, by=1)

> R = 6350*exp(-t/13.2)

> plot(t, R, pch=20, cex=0.5, xlab=“t (min)”, ylab=“R (cpm)”,

xlim=c(0, 150), ylim=c(0, 7000), grid())

This plot is shown above, on the left.
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We now plot R(t) using a logarithmic scale for R. So that we avoid infinities, we
change the lower limit of R to 0.1 cpm.

# Scatter plot with logarithmic R scale:

plot(t, R, log=''y'', pch=20, cex=0.5, xlab=''t (min)'', ylab=''R (cpm)'',

xlim=c(0, 150), ylim=c(0.1, 10000), grid())

This plot is shown above, on the right.

Example 12.14

With the aim of determining their density, we measure the diameters of 7 metal
spheres, as well as their masses. The results are given in columns 2 and 3 of the
table below. Assuming that the ‘spheres’ are perfectly spherical, find their density
using a graphical method.

The condition ‘using a graphical method’ is obviously imposed because we could
determine the density of each sphere directly and then find the mean value and its
standard deviation. However, for demonstration purposes, we will use the graphical
method.

The relation between the mass m and the diameter D of a sphere is m ¼ p
6 qD

3,
where q is its density. If we use the new variable x ¼ D3, we have the linear relation
m ¼ p

6 qx. The straight line mðxÞ passes through the origin and has a slope equal to
k ¼ p

6 q .

# D (cm) m (g) D3 ðcm3Þ
1 0.512 0.824 0.1342

2 0.635 1.362 0.2561

3 0.781 3.285 0.4764

4 0.906 4.401 0.7437

5 1.015 6.428 1.0457

6 1.152 10.853 1.5288

7 1.316 13.806 2.2791

The values of the variable D3 are given in the table. The mass m is plotted as a
function of D3 in the figure that follows, where the linear relationship between the
variables D3 and m is seen.
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The slope of the straight line is found to be approximately equal to k ¼ 6:30 g/cm3,
from which we find that q ¼ 6

p k ¼ 12:0 g/cm3.
A simple method of obtaining an estimate for the error in the density will be

presented below. It should be noted that for each point we could also have drawn
the errors in both D3 (as they are evaluated from the accuracy of measuring D) and
in the masses m of the spheres.

12.5 The Slope of the Curve

The most accurate method for finding the best straight line or, in general, the best
curve which corresponds to a series of experimental points, is the method of least
squares which, at least in the case of the straight line, also gives the errors in the
values of the two parameters which describe the line. The method has been pre-
sented in Chap. 11. Here, we will describe how we may find the slope of a straight
line or of a curve at a point by a graphical method.

By the term ‘best straight line’ we mean a straight line that passes between the
experimental points in such a way that, to the degree that this is possible, there are
equal numbers of points above and below the line, both in the case of all the points
and in as many smaller regions of values of the points as possible. Obviously this is
not easy or possible, unless there are a great number of points with most of them not
deviating by much more than the others from the general linear trend. Drawing this
line requires more than the use of a transparent ruler. It is already becoming clear
that this process depends on a number of subjective judgments. The same is true for
non-linear curves, with the difference that in their case things are more difficult.
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In general, large and sudden changes in the slope of the curve should be avoided,
unless this is justified by the systematic behavior of an adequate number of points.

Having drawn what in our judgment is the best curve, we may find for a straight
line its intercepts with the axes and its slope, and for a curve its slope at a certain
point of interest. In Fig. 12.27a the method of finding the slope of a straight line is
described. Having drawn the best straight line between the points, we choose two
geometrical points on the line, A and B. These points must not be experimental
points; otherwise the procedure would virtually cancel itself by giving weight to only
two experimental points, ignoring all the others! For more accurate results, points A
and B must at as great a distance from each other as possible. Also, for better reading
of the co-ordinates of these points but also in order to simplify arithmetic, it is
desirable that these points have abscissas (x) which correspond to whole numbers or
integers or, in any case, to numbers for which there correspond lines on the graph
paper used (for example, in Fig. 12.27a, the abscissas of points A and B are 2 and
12). The same comments apply in case we might choose to start by selecting two
points with given values of the dependent variable (y). We read the co-ordinates of
the points, A:(xA; yAÞ and B:(xB; yBÞ. The slope of the straight line is

k � dy
dx

¼ Dy
Dx

¼ yB � yA
xB � xA

: ð12:13Þ
The need for as large as possible values of the differences xB � xA and yB � yA is
obvious, since, otherwise, the reading errors in the co-ordinates will be significant
fractions of the differences xB � xA and yB � yA. It will be mentioned here that the
units of the slope are given by the relation:

Units of slope½ � ¼ Units of y½ �= Units of x½ �: ð12:14Þ

Fig. 12.27 The evaluation of the slope of a a straight line and b a curve at a point P
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It must also be mentioned that the point of view that the slope is equal to tan h,
where h is the angle formed by the straight line with the x-axis is wrong. This is true
only in those cases that the scales of the variables x and y are such that it is

(units of x per unit of length of the x-axis) = (units of y per unit of length of the
y-axis).
It must also be taken into account that the slope has dimensions while tan h is a pure
(dimensionless) number.

In the general case of a curve, having drawn the curve, we also draw a tangent
AB to the curve at the point P at which we wish to determine the slope of the curve,
Fig. 12.27b. The required slope at P, ðdy=dxÞP, is equal to the slope of this tangent
and is evaluated as described above.

12.5.1 A Graphical Method of Evaluating the Errors da
and dk in the Parameters a and k of the Straight Line
y ¼ aþ kx

A graphical method is described here for the determination of the errors da and dk
in the parameters a and k of the straight line y ¼ aþ kx, which is simpler than the
method of least squares. Although subjective judgments are made in applying the
method, its results are satisfactory in most cases. It must be borne in mind, however,
that the values of the errors found by this method have uncertainties of the order of
50% or even more.

Having drawn the best straight line for the given points and found the values of
the parameters a and k, we determine their errors by the following procedure (see
Fig. 12.28):

Fig. 12.28 The
determination, by a graphical
method, of the errors in the
slope of a straight line and in
the points of intersection of
the axes by the line
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1. We draw the best straight line, 1, passing between those points which lie above
the main straight line on the left and below the main straight line on the right.
The line we draw in this way is given by the equation y ¼ a1 þ k1x and from its
slope and its intercept with the y-axis we determine the values of k1 and a1,
respectively.

2. We draw the best straight line, 2, passing between those points which lie below
the main straight line on the left and above the main straight line on the right.
The line we draw in this way is given by the equation y ¼ a2 þ k2 x and from its
slope and its intercept with the y-axis we determine the values of k2 and a2,
respectively.

Satisfactory estimates for the errors in a and k are the values

da ¼ 1
2
ða1 � a2Þ and d k ¼ 1

2
ðk2 � k1Þ: ð12:15Þ

Example 12.15

Find the values of the parameters a and k and of their errors da and dk for the
straight line y ¼ aþ kx of Fig. 12.28.

Referring to Fig. 12.28, we choose to find the ordinates of the three lines which
correspond to the values x ¼ 0 and x ¼ 13. These are:

Main line: x ¼ 0; y ¼ 1:75ð Þ x ¼ 13; y ¼ 10:25ð Þ
Line 1: x ¼ 0; y ¼ 2:25ð Þ x ¼ 13; y ¼ 9:55ð Þ
Line 2: x ¼ 0; y ¼ 1:20ð Þ x ¼ 13; y ¼ 10:85ð Þ

We consider these magnitudes to be dimensionless, so that we do not have to give
units.

The points of intersection of the y-axis are: a ¼ 1:75; a1 ¼ 2:25 ; a2 ¼ 1:20.
The slopes of the straight lines are:

k ¼ 10:25� 1:75
13� 0

¼ 8:50
13

¼ 0:654

k1 ¼ 9:55� 2:25
13� 0

¼ 7:30
13

¼ 0:562 k2 ¼ 10:85� 1:20
13� 0

¼ 9:65
13

¼ 0:742:

The errors are

da ¼ 1
2
ð2:25� 1:20Þ ¼ 0:5 and dk ¼ 1

2
ð0:742� 0:562Þ ¼ 0:09:

Finally,

a ¼ 1:8� 0:5 and k ¼ 0:65� 0:09:
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Example 12.16 [E]

A converging lens is used for the formation of the image of a bright object. If the
distance of the object from the center of the lens is s, then the distance of the image
from the center of the lens is s0 and the two distances are connected by the relation
1
s þ 1

s0 ¼ 1
f , where the length f is characteristic of the particular lens used and is

called the focal length of the lens.
Given in the table that follows are pairs of values of s and s0, as these were

determined experimentally for a particular lens.

Column A s (cm) 13 14 15 16 18 20 25

Column B s0 (cm) 43.0 35.0 30.0 27.0 22.5 20.0 16.7

(a) Mark in a graph the points ðs; s0Þ. Assume that the values of s are known with
errors of �0:5 cm and that the values of s0 have fractional errors equal to ±5%
and draw the errors �ds and �ds0 for every point of the graph. Investigate
whether there are any points that you think should be neglected as the results of
wrong measurements.

(b) Use the theoretical relation between s and s0 for the determination of the focal
length f of the lens as follows: From the theoretical relation it follows that
s0 ¼ f 1þ s0=sð Þ. Make a table in which you record the values of s and s0, with
their errors, ds and ds0, and the corresponding values of the variable x ¼
1þ s0=s with their errors, d x.

Column A Column B Column C Column D Column E Column F

s (cm) s0 (cm) ds (cm) ds΄ (cm)
x ¼ 1þ s0

s
dx

Plot the points ðx; s0Þ, with their errors �dx and �ds0, and the best straight line that
passes between these points. From the value of the slope of the straight line
determine the focal length of the lens, f .

(a) We enter the values of s; s0; ds and ds0 in the columns A, B, C and D,
respectively. We highlight columns A and B and, from Insert, we select the
plot Scatter for them.

We delete the Chart Title text box. We double-click on a point and change the
color of the points to black. We open þ , Error Bars, More options, to open the
Format Error Bars window. In , Horizontal Error Bars, we select Direction:
Both and End Style: Cup. We also select Error Amount: Custom and tick the
Specify Value box. In the window that opens, we type = Sheet1!$C$1:$C$7 in
both Positive and Negative Error Value. We repeat for the Vertical Error Bars.
In the last step, we type = Sheet1!$D$1:$D$7 in both Positive and Negative Error
Value.

In þ , we select Axis Titles. We change the X-Axis Title to s (cm) and black
color. We change the Y-Axis Title to s′ (cm) and black color.
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We double-click on the X-Axis and open the Format Axis window. In , Axis
Options, we select Bounds Minimum 10,Maximum 30, Units Major 5,Minor 1.
In Tick Marks, we select Cross for both Major and Minor Type.

For the Y-Axis, in , Axis Options, we select Bounds Minimum 0,Maximum
50, Units Major 10,Minor 5. In Tick Marks, we select Cross for bothMajor and
Minor Type.

In Format Axis > Text Options > Text Fill, we select color black for both
axes.

In þ , Grid Lines, we also tick Primary Minor Horizontal and Primary
Minor Vertical grid lines.

We finally obtain the graph shown on the left below.

We see that the points lie on a smooth curve and that there do not appear to be
any points that should be neglected as the results of wrong measurements.

(b) The theoretical relation between s and s0 may be written as s0 ¼ f 1þ s0=sð Þ. We
enter the values of x ¼ 1þ s0=s in column E. In cell E1 we type = 1 + B1/A1.
After ENTER, we fill down from E1 to E7.

We estimate the errors in x from the errors in s and s0. From the theory of the
propagation of errors we have

dx ¼ ðx� 1Þ
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
ds
s

� �2

þ ds0

s0

� �2
s

:

In cell F1 we type = (E1 − 1) * sqrt((C1/A1)^2 + (D1/B1)^2). After ENTER,
we fill down from F1 to F7. Column F now contains the values of dx.

We will plot the points ðx; s0Þ with their errors. We copy column B, which
contains s0, in column G. We highlight columns E and G and through Insert we
choose a scatter plot for these two variables.

We delete the Chart Title text box. We double-click on a point and change the
color of the points to black. We open þ , Error Bars, More options, to open the
Format Error Bars window. In , Horizontal Error Bars, we select Direction:
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Both and End Style: Cup. We also select Error Amount: Custom and tick the
Specify Value box. In the window that opens, we type = Sheet1!$F$1:$F$7 in
both Positive and Negative Error Value. We repeat for the Vertical Error Bars.
In the last step, we type = Sheet1!$D$1:$D$7 in both Positive and Negative Error
Value.

In þ , we select Axis Titles. We change the X-Axis Title to x = 1 + s′/s and
black color. We change the Y-Axis Title to s′ (cm) and black color.

We double-click on the X-Axis and open the Format Axis window. In , Axis
Options, we select Bounds Minimum 0, Maximum 5, Units Major 1, Minor 0.5.
In Tick Marks, we select Cross for both Major and Minor Type.

For the Y-Axis, in , Axis Options, we select Bounds Minimum 0,Maximum
50, Units Major 10,Minor 5. In Tick Marks, we select Cross for bothMajor and
Minor Type.

In Format Axis > Text Options > Text Fill, we select color black for both
axes.

In þ , Grid Lines, we also tick Primary Minor Horizontal and Primary
Minor Vertical grid lines.

We open þ , Trendline, More Options. We choose Linear and Set Intercept
to (0, 0). We also choose for the equation of the line to be shown in the plot. The
final result is shown above by the figure on the right above.

The equation of the line is given as s΄ = 10.001x. This means that the value of
the focal length is f = 10.001 cm. It is obvious that the error in f as derived from the
points of the plot would be about 10 times smaller than that expected from the
errors in x and s΄ of the points.

Example 12.17 [O]

Solve Example 12.16 [E] using Origin®.

We fill columns A and B with the values of s and s′ and label them s (cm) and s′
(cm), respectively. The values of ds and ds0 are entered in columns C and D. We
select column C and then

Column > Set As > X Error
We select column D and then,

Column > Set As > Y Error
We select columns A, B, C and D and

Plot > Symbol > Scatter
A graph appears, showing the points ðs; s0Þ with their error bars (see below, left).
We will improve the appearance of the graph.

1. We delete the two text box given in the figure.
2. The labels and ranges of the two axes are in an acceptable form. The ranges are

12–26 cm for the s-axis and 15–45 cm for the s′-axis.
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We export the graph using

File > Export Graphs > Open Dialog…

Select Image Type (say jpg), File Name and Path. The figure may be imported
in the text here. The result is shown in the figure on the left below. It is seen that all
the points lie on a smooth curve and no point needs to be rejected.

In column E we enter the values of x ¼ 1þ s0=s as follows:

Column > Set Column Values

and entering 1 + col(B)/col(A). Pressing OK fills column E with the x values.
We estimate the errors in x from the errors in s and s0. From the theory of the

propagation of errors we have

dx ¼ ðx� 1Þ
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
ds
s

� �2

þ ds0

s0

� �2
s

:

We highlight column F. Then

Column > Set Column Values

and type (col(E) − 1) * sqrt((col(C)/col(A))2 + (col(D)/col(B))2) and then OK.
The errors in x are entered in column F.

We arrange the data in columns in preparation for plotting s′(x).
Column E contains the values of x. We highlight column E and then

Column > Set As > X

Column F contains the values of dx. We highlight column F and then

Column > Set As > X Error

We copy column B in column G. We highlight column G and then

Column > Set As > Y
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We copy column D in column H. We highlight column H and then

Column > Set As > Y Error

We highlight columns E, F, G and H. Then

Plot > Symbol > Scatter

A graph appears, showing the points ðx; s0Þ with their error bars.
We will improve the appearance of the graph.

1. We delete the text box given in the figure.
2. We double-click on a point and change the shape and size of the points from

square and 8 pts to circular and 5 points.
3. We change the labels of the axes by double-clicking on them and writing

x = 1 + s′/s in place of x and s′ (cm) for the Y axis. We use the default font of
Arial 22 pts.

4. The ranges of the axes are satisfactory.

While in the graph of ðx; s0Þ we select
Analysis > Fitting > Linear Fit > Open Dialog
Press OK. A straight line is drawn between the experimental points.
Double-click on the line and change its color from red to black and its thickness

from 0.5 to 1. Press OK.
The result is shown in the figure on the right above.
The straight line has a slope of 9.98841 ± 0.02756 cm. The focal length of the

lens is, therefore, equal to f = 9.99 ± 0.03 cm.

Example 12.18 [P]

Solve Example 12.16 [E] using Python.

(a) We first plot the graph s′(s).

import numpy as np

import matplotlib.pyplot as plt

s1 = np.array([13, 14, 15, 16, 18, 20, 25])

s2 = np.array([43, 35, 30, 27, 22.5, 20, 16.7])

errs1 = np.array([0.5, 0.5, 0.5, 0.5, 0.5, 0.5, 0.5])

errs2 = 0.05*s2

plt.errorbar(s1, s2, xerr=errs1, yerr=errs2, fmt=‘o’, color=‘b’)

plt.xlim(11, 27)

plt.ylim(12,48)

plt.xlabel(''s'')

plt.ylabel(''s''')

plt.grid(True)

plt.show()

The resulting scatter plot is shown in the figure below, on the left.
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(b) We will now plot s′(x).

We evaluate x ¼ 1þ s0=s and its errors dx ¼ ðx� 1Þ
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
ds
s

� �2 þ ds0
s0

� �2q
.

x = 1 + s2/s1

errx = (x-1)*np.sqrt((errs1/s1)**2 + (errs2/s2)**2)

We plot a scatter plot of x versus s2. We also add the best-fit least-squares straight
line:

plt.errorbar(x, s2, xerr=errx, yerr=errs2, fmt='o', color='b')

plt.xlim(0, 5)

plt.ylim(0, 50)

plt.xlabel(''x = 1 + s'/s'')

plt.ylabel(''s' (cm)'')

plt.grid(True)

fit = np.polyfit(x, s2, 1)

p = np.poly1d(fit)

xp = np.linspace(0, 5, 200)

plt.plot(xp, p(xp), '-', color=''black'')

plt.show()

The resulting graph is shown in the figure on the right, above. By looking at the
contents of the p object (the polynomial of the straight line fit to the data) we get:

In[]: p

Out[]: poly1d([ 9.97003572, 0.0928256 ])

Therefore, we calculated intercept = 0.09283 cm and slope = 9.97004 cm. This
means that the focal length of the lens is f = 9.97 cm.
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Example 12.19 [R]

Solve Example 12.16 [E] using R.

(a) We first plot the graph s′(s).

# data vectors:

s1 <- c(13, 14, 15, 16, 18, 20, 25)

s2 <- c(43, 35, 30, 27, 22.5, 20, 16.7)

errs1 <- c(0.5, 0.5, 0.5, 0.5, 0.5, 0.5, 0.5)

errs2 = 0.05*s2

# scatter plot of data with s1 and s2 axes labels, lengths and grid:

plot(s1, s2, pch=20, xlab=''s'', ylab=''s''', xlim=c(11, 27),

ylim=c(12, 48), grid())

# add s1 error bars

arrows(s1-errs1, s2, s1+errs1, s2, length=0.02, angle=90, code=3)

# add s2 error bars

arrows(s1, s2-errs2, s1, s2+errs2, length=0.02, angle=90, code=3)

The resulting scatter plot is shown in the figure below, on the left.

We see that there do not appear to be any points that should be neglected as the
results of wrong measurements.

(b) We will now plot s′(x).

We evaluate x ¼ 1þ s0=s and its errors dx ¼ ðx� 1Þ
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
ds
s

� �2 þ ds0
s0

� �2q
.

# evaluate x and its errors:

x = 1+s2/s1

errx = (x-1)*sqrt((errs1/s1)^2+(errs2/s2)^2)

#scatter plot of data with x and s2 axes labels, lengths and grid:

plot(x, s2, pch=20, xlab=“x = 1 + s’/s”, ylab=“s’ (cm)”, xlim=c(0, 5),
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ylim=c(0, 50), grid())

# add x error bars

arrows(x-errx, s2, x+errx, s2, length=0.02, angle=90, code=3)

# add s2 error bars

arrows(x, s2-errs2, x, s2+errs2, length=0.02, angle=90, code=3)

The resulting graph is shown in the figure on the right, above.
We find the best-fit least-squares straight line through the points:

# find least-squares best-fit straight line:

fit <- lm(s2*x)

fit

# Plot least-squares best-fit straight line:

abline(fit)

The best-fit least-squares straight line is also drawn in the figure.
The least-squares fit gives: intercept = 0.09283 cm and slope = 9.97004 cm.

This means that the focal length of the lens is f = 9.97 cm. An estimate of the error
in f can be made, based on the scatter of the experimental points about the straight
line. It appears to be less than 1%.

12.5.2 The Evaluation of Slopes of Straight Lines in Graphs
with Logarithmic Scales

We will now discuss the way to evaluate the slopes of straight lines in graphs with
one or both the scales being logarithmic.

12.5.2.1 Two Logarithmic Scales

In the case of a straight line in a graph with two logarithmic scales, if the actual
values of the logarithms are marked on the axes, the slope is found as described
above for a straight line in a graph with linear axes. We must remember that, in this
case, the slope, being the ratio of two differences of logarithms, is a dimensionless
number. Also, since the common logarithm and the natural logarithm are related by
the expressions

z ¼ 10log z; ln z ¼ ðln 10Þ log z; ln z ¼ ð2:3026. . .Þ � log z; ð12:16Þ

z ¼ eln z; log z ¼ ðlog eÞ ln z; log z ¼ ð0:4343. . .Þ � ln z; ð12:17Þ
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i.e. through a multiplying factor, the value of the slope is the same both in the case
of two scales of common logarithms and in the case of two scales of natural
logarithms.

More frequently, however, although the scales are logarithmic, log x and log y,
the numbers x and y are marked on them, as for example in Fig. 12.29. In these
cases, if A and B are two geometrical (not experimental) points on the straight line,
the slope is given by the ratio

j � D log y
D log x

¼ log yB � log yA
log xB � log xA

or j � D ln y
D ln x

¼ ln yB � ln yA
ln xB � ln xA

ð12:18Þ

After we read the values of x and y off the graph, we must substitute their loga-
rithms, common or natural, in Eq. (12.18). The slope j, being the ratio of two
differences of logarithms, is a dimensionless quantity (pure number).

Points A and B must be chosen to be at a distance between them as large as
possible, but also at such positions that the reading of the values of x and y may be
done with as much accuracy as possible, especially since the scales are not linear.
Of course, on the logarithmic paper usually used, there are lines at as many sub-
divisions as possible, more than in our figures, and the reading of values is easier.

As a numerical example, we evaluate the slope of the straight line of Fig. 12.9,
which we reproduce here as Fig. 12.30. We choose points A and B to have Va ¼ 1
and 100 V, respectively. The corresponding values of Ia are 5:0� 10�5 and 5:0�
10�2 A. Thus, we have for the slope

Fig. 12.29 The evaluation of the slope of a straight line in a graph with two logarithmic scales
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j ¼ log IB � log IA
log VB � log VA

¼ logð5:0� 10�2Þ � logð5:0� 10�5Þ
logð100Þ � logð1Þ

¼ ð�1:301Þ � ð�4:301Þ
2� 0

¼ 3
2
; ð12:19Þ

as predicted by theory.
A second example is given in Fig. 12.31, in which the periods of revolution of

the planets around the Sun, T, are plotted as a function of their distances from it, a,

Fig. 12.30 A numerical example of the evaluation of the slope of a straight line in a graph with
two logarithmic scales. The notation 1E-3 ¼ 10�3 etc. is used for powers of 10

Fig. 12.31 Kepler’s third law (Fig. 12.10). A numerical example of the evaluation of the slope of
a straight line, in a graph with two logarithmic scales
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using logarithmic scales. The relationship is seen to be linear. For the calculation of
the slope we use the points Earth: (1, 1) and B: (100, 1000). The slope of the line is

j ¼ log TB � log TEarth
log aB � log aEarth

¼ logð1000Þ � logð1Þ
logð100Þ � logð1Þ ¼ 3

2
; ð12:20Þ

verifying Kepler’s third law, T / a3=2.
A third example is shown in Fig. 12.32, in which the force F between two point

electric charges is plotted as a function of the distance between them, r. We use the
points

A:ð4:5� 10�4 m, 1� 10�3 N) and B : ð0:045 m, 1� 10�7 N) ð12:21Þ

and find for the slope of the straight line the value

j ¼ logð1� 10�7Þ � logð1� 10�3Þ
logð0:045Þ � logð4:5� 10�4Þ ¼ ð�7Þ � ð�3Þ

ð�1:347Þ � ð�3:347Þ ¼
�4
2

¼ �2:

ð12:22Þ

Therefore, it is

logF ¼ K � 2 log r or F ¼ A=r2; ð12:23Þ

as expected from Coulomb’s law.

Fig. 12.32 The force F between two point charges as a function of their distance r
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12.5.2.2 One Linear Scale and One Logarithmic Scale

We will assume that the logarithmic scale is that of the dependent variable (y), as in
Fig. 12.33. If A and B are two (geometrical) points on the straight line, the slope is
given by the ratio

j � D ln y
D x

¼ ln yB � ln yA
xB � xA

ð12:24Þ

and, after we read the values of x and y, we must substitute for the natural loga-
rithms of the y values in Eq. (12.23). This presupposes that the relation connecting
x and y is of the form

y ¼ A ej x: ð12:25Þ
This is no limitation, as the relation may be transformed to an exponential of any
other base, through the relation y ¼ A aðj= ln aÞ x. It should be noted that, since the
difference in the logarithms for yA and yB is the logarithm of their ratio, which is a
dimensionless quantity, the units of the slope j are the inverse of those of x:

Units of the slope j½ � ¼ 1= Units of x½ �: ð12:26Þ

Points A and B must be chosen to be at as great a distance from each other as
possible and in such positions that they make the reading of the values of y as
accurate as possible, also taking into account the fact that the scale is not linear.
A good choice of points would be those with yA ¼ 10 and yB ¼ 10 000. We start
with values of y, since we can choose such values that are easy to read off the graph

Fig. 12.33 The evaluation of the slope of a straight line in a graph with one linear scale and one
logarithmic scale
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than other values of y which do not correspond to a grid line of the logarithmic scale.
This would have been the difficulty, had we started by choosing two values of x.

A numerical example is given in Fig. 12.34, in which we reproduce the variation
as a function of time of the disintegration counting rate, R, of a radioactive sample
of Fig. 8.2.

As points A and B we choose those with RA ¼ 10 000 and RB ¼ 10 c.p.m. The
co-ordinates of these points are A: (0, 104 c.p.m.) and B: (138 min, 10 c.p.m.).
Then,

j ¼ ln RB � ln RA

tB � tA
¼ lnð10Þ � lnð104Þ

138� 0
¼ 2:303� 9:210

138
¼ �0:0501min�1:

ð12:27Þ

Alternatively, we may choose as points A and B those with t ¼ 0 and t ¼ 160 min.
The co-ordinates of these points are A: (0, 104 c.p.m.) and B: (160 min, 3.3 c.p.m.).
The slope of the straight line is:

j ¼ ln RB � ln RA

tB � tA
¼ lnð3:3Þ � lnð104Þ

160� 0
¼ 1:194� 9:210

160
¼ �0:0501min�1:

ð12:28Þ

Fig. 12.34 A numerical example of the evaluation of the slope of a straight line in a graph with
one linear scale and one logarithmic scale. The graph shows the variation with time of the counting
rate of a radioactive sample
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From the law of radioactivity, RðtÞ ¼ R0e�k t, we expect

ln R ¼ ln R0 � k t ð12:29Þ

so that the slope found is j ¼ �k. It follows from these measurements that for the
particular radioisotope it is k ¼ 0:050min�1. The mean life-time of the isotope is
s ¼ 1=k ¼ 20min. The errors in these values could be found either by a graphical
method or the method of least squares applied to the straight line ln RðtÞ. It can be
seen that these errors are mostly due to the dispersion of values at low R’s.

Another example is given in Fig. 12.35, which shows a series of measurements
similar to that of Fig. 12.15. The slope of the straight line may be found from the
points

A: ð1=T ¼ 1� 10�3 K�1; log10 sðs) ¼ �2:8Þ
and B: ð1=T ¼ 11� 10�3 K�1; log10 sðs) ¼ 3:5Þ:

We change the common logarithms to natural logarithms by multiplying then by
2.3026:

A: ð1=T ¼ 1� 10�3 K�1; ln sðs) ¼ �6:45Þ
and B: ð1=T ¼ 11� 10�3 K�1; ln sðs) ¼ 8:06Þ:

Fig. 12.35 An Arrhenius diagram (log10s – 1/T)
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The slope of the straight line is

j ¼ ½ln sðsÞ�B � ½ln sðsÞ�A
1=TB � 1=TA

¼ 8:06� ð�6:45Þ
11� 10�3 � 1� 10�3 ¼

14:51
10�2 ¼ 1451K: ð12:30Þ

Assuming a relation of the form s ¼ s0eE=kT [Eq. (12.8)], where k is Boltzmann’s
constant, s0 a time constant and E an energy, we find that the straight line

ln s ¼ ln s0 þ E
k
1
T

ð12:31Þ

which results from plotting the values of ln s as a function of 1=T has a slope of

j ¼ E
k
: ð12:32Þ

Therefore, the experimental values give

j ¼ E
k
¼ 1451K: ð12:33Þ

As it is 1=k ¼ 11604:5 K/eV, the value of the energy E is

E ¼ 1451
11604:5

¼ 0:125 eV: ð12:34Þ

Given that the accuracy with which values are read off the graph cannot be better
than about 2%, we accept that �2% is a reasonable estimate for the fractional error
in the value of E. Thus,

E ¼ 0:125� 0:003 eV, ð12:35Þ

unless we have another indication from the dispersion of the experimental points.

12.5.2.3 The Graphical Resolution of the Activity of a Radioactive
Sample into Components

It is often the case that the activity of a radioactive sample is due to two or more
radioisotopes, with different decay constants. In the case of two radioisotopes with
comparable activities but having decay constants which are quite different the
separation of their activities is possible by a graphical method.
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If the total activity of the sample is

R ¼ RA þRB ¼ R0Ae�kAt þR0Be�kBt ð12:36Þ

and we have at our disposal a large enough number of measurements at different
times t, the curve of the total activity as a function of time will be as the curve
A + B of Fig. 12.36. At large values of time, the activity of the shorter-lived of the
two radioisotopes is reduced to negligible values compared to the activity of the
other radioisotope. If the plot is log R � t, and the background, which is inde-
pendent of time, has been subtracted, the straight line B may be determined, which
gives the activity of radioisotope B. Subtracting this from the total activity, we find
the activity of radioisotope A. In this way we may determine the quantities
kA; kB; R0A and R0B. In the example of Fig. 12.35, it is found that
sA ¼ 1=kA ¼ 20 min, sB ¼ 1=kB ¼ 80 min, R0A ¼ 10; 000 c:p:m: and R0B ¼
3000 c:p:m: Obviously, the graphical method has a limited accuracy. More accurate
results may be obtained by numerical methods. The method is very rarely useful for
more than two radioisotopes.

Example 12.20 [O]

Measurements of the activity of a radioactive sample, R, are given for 0� t� 150
min (They are the same as those of Example 8.5). Plot logR(t) and verify that the
activity seems to be due to two isotopes with different decay constants. Assume that
the activity is given by R ¼ R10e�t=s1 þR20e�t=s2 and find the parameters of the
functions.

Fig. 12.36 The graphical resolution of the activity of a radioactive sample into two components,
A and B, due to two different radioisotopes
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The values of t are entered in column A and those of R in column B. We plot logR
(t). While in the graph environment, we press

Analysis > Fitting > Nonlinear Curve Fit > Open Dialog…

In the window that opens we select

Settings > Function Selection > Origin Basic Functions > Exponential >
ExpDec2

The curve fitted is y = A1 * exp(−x/t1) + A2 * exp(−x/t2) + y0. We want to
set y0 = 0.

Open Parameters. Tick y0 and set its value to zero. Press Fit. The results are:

A1 ¼ R10 ¼ 9950� 48 c:p:m:; t1 ¼ s1 ¼ 19:88� 0:10min

A2 ¼ R20 ¼ 3036� 51 c:p:m:; t2 ¼ s2 ¼ 79:43� 0:95 min

The curve R ¼ R10e�t=s1 þR20e�t=s2 is plotted in the graph. We also plot R1 ¼
R10e�t=s1 and R2 ¼ R20e�t=s2 .

The graph is shown in the figure presented above.

Is a resolution into three components possible? A radioactive sample contains
three radioisotopes, A, B and C, which contribute counting rates
RAðtÞ ¼ 10 000 e�t=100, RBðtÞ ¼ 2000 e�t=300 and RCðtÞ ¼ 300 e�t=900, respec-
tively, in c.p.m. when t is in min. The total counting rate of the sample is
RðtÞ ¼ RAðtÞþRBðtÞþRCðtÞ. Discuss the possibility of performing a graphical
analysis of this curve into its three components. Assume that the counting rates are
evaluated using the results of 10-minute measurements Fig. 12.37.

From the figure, it is seen that drawing a tangent to the R(t) curve is not easy. It
should be noted that at the lower point of the curve, a 10-min measurement will
give the result of 20� 10 ¼ 200� 14 counts, corresponding to a counting rate of
20� 1:4 c:p:m: We see that there is an error of 7% in the counting rates at times
near 2500 min. This makes drawing a tangent to the curve even more difficult. The
best we can do is to draw two straight lines, C1 and C2 as the limiting cases
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between which the correct tangent lies. We find that these lines cut the R axis at
RC1ð0Þ ¼ 200 and RC2ð0Þ ¼ 400 c.p.m., respectively, and correspond to lifetimes
equal to sC1 ¼ 1062min and sC2 ¼ 820min. The limiting cases for the counting
rate from isotope C are RC1ðtÞ ¼ 200 e�t=1062 and RC2ðtÞ ¼ 400 e�t=820 c.p.m.

Subtracting the straight lines C1 and C2 from the total R(t), we have the curves
AB1 and AB2, which are the limits within which RAðtÞþRBðtÞ lies. The tangents
to these curves at high times give the straight lines B1 and B2 for isotope B. The
equations of these lines are found to be RB1ðtÞ ¼ 2900 e�t=245 and
RB2ðtÞ ¼ 1700 e�t=341.

Subtracting the sums B1 + C1 and B2 + C2 from the total R(t), we have the
curves A1 and A2, which are supposed to be giving the counting rate from isotope
A. These curves are far from being straight. The method is seen to fail for the
analysis of a curve with counting rates from three isotopes.

Example 12.21 [O]

In the special theory of relativity, we are interested in the quantities

c ¼ 1ffiffiffiffiffiffiffiffi
1�b2

p ; bc; D ¼
ffiffiffiffiffiffiffiffi
1�b
1þb

q
and 1=D ¼

ffiffiffiffiffiffiffiffi
1þb
1�b

q
, especially at values of the speed

approaching that of light in vacuum, c, since then the reduced speed b ¼ t=c
approaches unity and some of these quantities diverge. We wish to find suitable
scales that will show the detail in the above quantities at values of b approaching
unity.

Fig. 12.37 The graphical resolution of the activity of a radioactive sample into three components,
A, B and C, due to three different radioisotopes
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We plot these quantities on a logarithmic scale from 0.02 to 50, as functions of the
variable 1� b, for values of b increasing from 0 to 0.999. We use a logarithmic
scale for 1� b, but instead of setting the range of this from 0.001 to 1 we invert this
scale by setting the range to be from 1 to 0.001. This means that the leftmost point
of the X-axis will correspond to the value b ¼ 0 and the one on the extreme right
will correspond to b ¼ 0:999, increasing from left to right. On the X-axis, instead
of giving the values of 1� b, we give those of b. This means that the values of b
are not entered automatically but have to be inserted ‘by hand’. The results are
shown in the graph that follows.

It is seen that, due to the method used, the scale for b can be made as detailed as we
like for b ! 1, by adding more decades to the logarithmic scale of 1� b.

Programs

Excel
Ch. 12. Excel—Column and Label
Ch. 12. Excel—Histogram
Ch. 12. Excel—Scatter Plot—Linear Scales
Ch. 12. Excel—Scatter Plot—Linear Scales—Errors
Ch. 12. Excel—Scatter Plot—Linear Scales—Multiple
Ch. 12. Excel—Scatter Plot—Linear-Log Scales
Ch. 12. Excel—Scatter Plot—Linear-Log Scales—Errors
Ch. 12. Excel—Scatter Plot—Linear-Log Scales—Multiple
Ch. 12. Excel—Scatter Plot—Log-Linear Scales
Ch. 12. Excel—Scatter Plot—Log-Linear Scales—Errors
Ch. 12. Excel—Scatter Plot—Log-Linear Scales—Multiple
Ch. 12. Excel—Scatter Plot—Log-Log Scales
Ch. 12. Excel—Scatter Plot—Log-Log Scales—Errors
Ch. 12. Excel—Scatter Plot—Log-Log Scales—Multiple

(continued)
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(continued)

Programs

Origin
Ch. 12. Origin—Column Plot
Ch. 12. Origin—Column and Label
Ch. 12. Origin—Histogram
Ch. 12. Origin—Scatter Plot—Linear Scales
Ch. 12. Origin—Scatter Plot—Linear Scales—Errors
Ch. 12. Origin—Scatter Plot—Linear Scales—Multiple
Ch. 12. Origin—Scatter Plot—Linear Scales—Weights
Ch. 12. Origin—Scatter Plot—Linear Scales—Errors—Weights
Ch. 12. Origin—Scatter Plot—Linear Scales—Errors—Weights from Errors
Ch. 12. Origin—Scatter Plot—Linear-Log Scales
Ch. 12. Origin—Scatter Plot—Linear-Log Scales—Errors
Ch. 12. Origin—Scatter Plot—Linear-Log Scales—Multiple
Ch. 12. Origin—Scatter Plot—Linear-Log Scales—Weights
Ch. 12. Origin—Scatter Plot—Linear-Log Scales—Errors—Weights
Ch. 12. Origin—Scatter Plot—Linear-Log Scales—Errors—Weights from Errors
Ch. 12. Origin—Scatter Plot—Log-Linear Scales
Ch. 12. Origin—Scatter Plot—Log-Linear Scales—Errors
Ch. 12. Origin—Scatter Plot—Log-Linear Scales—Multiple
Ch. 12. Origin—Scatter Plot—Log-Linear Scales—Weights
Ch. 12. Origin—Scatter Plot—Log-Linear Scales—Errors—Weights
Ch. 12. Origin—Scatter Plot—Log-Linear Scales—Errors—Weights from Errors
Ch. 12. Origin—Scatter Plot—Log-Log Scales
Ch. 12. Origin—Scatter Plot—Log-Log Scales—Errors
Ch. 12. Origin—Scatter Plot—Log-Log Scales—Multiple
Ch. 12. Origin—Scatter Plot—Log-Log Scales—Weights
Ch. 12. Origin—Scatter Plot—Log-Log Scales—Errors—Weights
Ch. 12. Origin—Scatter Plot—Log-Log Scales—Errors—Weights from Errors
Ch. 12. Origin—Polar Diagram
Ch. 12. Origin—Polar Diagram—Errors
Ch. 12. Origin—Polar Diagram—Weights
Ch. 12. Origin—Polar Diagram—Errors—Weights
Ch. 12. Origin—Polar Diagram—Errors—Weights from Errors

Python
Ch. 12. Python—Histogram
Ch. 12. Python—Column and Label
Ch. 12. Python—Scatter Plot—Linear Scales
Ch. 12. Python—Scatter Plot—Linear Scales—Errors
Ch. 12. Python—Scatter Plot—Linear Scales—Multiple
Ch. 12. Python—Scatter Plot—Linear-Log Scales
Ch. 12. Python—Scatter Plot—Linear-Log Scales—Errors
Ch. 12. Python—Scatter Plot—Linear-Log Scales—Multiple
Ch. 12. Python—Scatter Plot—Log-Linear Scales
Ch. 12. Python—Scatter Plot—Log-Linear Scales—Errors
Ch. 12. Python—Scatter Plot—Log-Linear Scales—Multiple
Ch. 12. Python—Scatter Plot—Log-Log Scales
Ch. 12. Python—Scatter Plot—Log-Log Scales—Errors
Ch. 12. Python—Scatter Plot—Log-Log Scales—Multiple

(continued)

12.5 The Slope of the Curve 443



(continued)

Programs

R
Ch. 12. R—Histogram
Ch. 12. R—Column and Label
Ch. 12. R—Scatter Plot—Linear Scales
Ch. 12. R—Scatter Plot—Linear Scales—Errors
Ch. 12. R—Scatter Plot—Linear Scales—Multiple
Ch. 12. R—Scatter Plot—Linear-Log Scales
Ch. 12. R—Scatter Plot—Linear-Log Scales—Errors
Ch. 12. R—Scatter Plot—Linear-Log Scales—Multiple
Ch. 12. R—Scatter Plot—Log-Linear Scales
Ch. 12. R—Scatter Plot—Log-Linear Scales—Errors
Ch. 12. R—Scatter Plot—Log-Linear Scales—Multiple
Ch. 12. R—Scatter Plot—Log-Log Scales—Errors
Ch. 12. R—Scatter Plot—Log-Log Scales
Ch. 12. R—Scatter Plot—Log-Log Scales—Multiple

Problems

12:1 [E.O.P.R.] The position y of a moving body is given as a function of time in
the table that follows:

t (s) 1.0 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0

y (m) 1.1 2.6 4.1 4.4 7.1 7.6 9.1 10.0 10.5

Mark the points ðt; yÞ in a graph.
Make sure that a straight line would adequately describe the relation yðtÞ and
that there are no points that should be rejected as due to measurements with
excessive errors.
Assume that a relation of the form y ¼ aþ k t holds for the variables y and t.
Complete a table and use the method of least squares in order to determine
the parameters a, k and their errors da and dk.
Mark the point K:ð�t; �y Þ on the graph.
Draw the following straight lines on the graph:

1. the straight line y ¼ aþ k t, using the values found for a and k
2. the straight line passing through point K and having a slope equal to

k� dk
3. the straight line passing through point K and having a slope equal to

kþ dk.
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12:2 [E.O.P.R.] Given in the table that follows, as a function of time t, are the
measurements of the distance y of a body from the origin, as this moves on
the y-axis.

t (s) 1.0 1.5 1.8 2.0 2.2 2.5

y (m) 30 50 68 73 100 110

(a) Mark the points ðt; yÞ on a graph. Suppose that the values of t are known
with errors equal to �0:2 s and that the values of y have fractional
errors equal to �7% and draw the errors �dt and �dy for each point.
Investigate whether there are any points that you think should be
neglected as the results of wrong measurements. Draw with a pencil the
best (smooth) curve passing between the points of the graph (perfection
is desirable but unattainable!).

(b) Assume that for y and t the relation y ¼ y0 þ 1
2c t

2 holds. Construct a
table in which you record the values of t, y and the corresponding
values of the variable x ¼ t2. Evaluate also and enter in the table the
errors dt, dy and dx in these magnitudes.

t (s) dt (s) y (m) dy (m) x ¼ t2 ðs2Þ d x ðs2Þ

Mark on a graph the points ðx; yÞ and draw their errors �d x and �d y. Verify
that the relation yðxÞ is linear to a good enough approximation and draw the
best in your judgment straight line between the points of the graph. Without
marking anything on the graph, find the coordinates of two points of the
straight line (geometrical points, not experimental) and evaluate its slope. For
better results, these points must be at a distance between them which is as
large as possible. From the intercept of the line with the y-axis and from its
slope, determine the values of y0 and c.
[E.O.P.R.] Use the methods of non-linear curve fitting to fit a curve of the
form y ¼ y0 þ 1

2c t
2 to the experimental points.

12:3 [E.O.P.R.] Given in the table that follows, as a function of time t, are the
measurements of the distance y of a body from the origin, as this moves on
the y-axis.

t (s) 1.0 2.0 3.0 4.0 5.0 6.0

y (m) 1.4 4.0 7.2 12.0 17.0 24.0

(a) Mark on a graph the points ðt; yÞ. Assume that the values of t are known
with great accuracy but in the values of y there are fractional errors
equal to �7% and draw the errors �dy for all the points. Investigate
whether there are any points that you think should be neglected as the
results of wrong measurements. Draw with a pencil and by hand the
best (smooth) curve passing between the points of the graph.

Problems 445



(b) Assume that the theoretical relation between y and t is the expression
y ¼ t0tþ 1

2c t
2. Make a table in which you record the values of t and

y and the corresponding values of the variable z ¼ y=t.

t (s) y (m) z ¼ y=t ðm=sÞ

Plot in a graph the points ðt; zÞ. Satisfy yourselves that the function zðtÞ is
linear. Draw the best, in your opinion, straight line that passes between these
points. Determine the coordinates of two points of the line (geometrical
points, not experimental) and evaluate its slope. From the intercept of the line
with the z-axis and its slope determine the values of t0 and c.

12:4 [E.O.P.R.] A mass m is connected to the free end of a spring which has a
constant k, and the other end of which is fixed. Theory predicts that the
motion of the mass, if this is displaced from its equilibrium point and let free,
is simple harmonic, with a period equal to T ¼ 2p

ffiffiffiffiffiffiffiffiffi
m=k

p
.

The table below shows the values of T for various masses m connected to
the same spring.

m (kg) 0.1 0.2 0.3 0.4 0.5 0.6 0.7

T (s) 1.00 1.50 1.80 2.05 2.15 2.55 2.70

(a) Mark the points ðm; TÞ on a graph. Assume that the values of m are
known with great accuracy and that the values of T have fractional
errors equal to �5% and draw the errors �d T of each point. Investigate
whether there are any points that you think should be neglected as the
results of wrong measurements. Draw with a pencil and by hand the
best (smooth) curve passing between the points of the graph.

(b) Use the theoretical relation T ¼ 2p
ffiffiffiffiffiffiffiffiffi
m=k

p
for the determination of the

constant k as follows: From the relation it follows that T2 ¼ 4p2=kð Þ m.
Construct a table in which you record the values of m and T and the
corresponding values of the variable y ¼ T2.

m (kg) T (s) y ¼ T2 ðs2Þ

Mark in a graph the points ðm; y ¼ T2Þ and the best, in your opinion,
straight line passing between them. Read off the straight line the coordinates
of two points (geometrical points, not experimental) and evaluate the slope of
the straight line. From the value of the slope evaluate the constant k.
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